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About Cabri Geometry Il

Cabri Geometry II lets you construct and explore geometric objects interactively.

Jean-Marie Laborde and Franck Bellemain developed Cabri Geometry II at the Institut
d'Informatique et Mathématiques Appliquées de Grenoble (IMAG), a research lab at the Université
Joseph Fourier in Grenoble, France, in cooperation with the Centre National de la Recherche
Scientifique (CNRS) and Texas Instruments.

Texas Instruments, the publisher for Cabri Geometry II in the United States and Canada, is pleased
to bring computer-based geometry to classrooms. The geometric foundation of this easy-to-use
software encourages exploring and conjecturing—from simple shapes to advanced projective and
hyperbolic geometry.

About the Developers

Jean-Marie Laborde is founder and Research Director of Laboratoire de Structures Discretes et de
Didactique (LSD2), a research laboratory within IMAG. He graduated in mathematics at Ecole
Normale Supérieure in Paris in 1969. He earned a Ph.D. (Thése d'Etat) in computer science at the
University of Grenoble in 1977. Jean-Marie began work on the Cabri II project in 1981 as an
environment for graph theory. He has devoted his research efforts to the use of geometric methods
for the study of different classes of graphs, especially hypercubes.

Franck Bellemain earned a Ph.D. in mathematics at the Université Joseph Fourier in 1992. He
began work on the Cabri II project in 1986 and is responsible for writing several versions of the
software for Macintosh, PC-compatible, and Japanese computers. His research and thesis have
been devoted to the use of technology in the classroom.

Cabri Geometry Il Features

* Includes interactive analytic, transformational, and Euclidean geometry.

« Allows intuitive construction of points, lines, triangles, polygons, circles, and other basic
objects.

« Translates, dilates, and rotates geometric objects around geometric centers or specified points
plus reflection, symmetry, and inverse of the objects.

«  Constructs conics easily, including ellipses and hyperbolas.

« Explores advanced concepts in projective and hyperbolic geometry.
+ Annotates and measures figures (with automatic updating).

«  Uses both Cartesian and polar coordinates.

«  Provides for user display of the equations of geometric objects, including lines, circles,
ellipses, and coordinates of points.

+ Allows the user to create macros for frequently repeated constructions.

« Lets the teacher configure tool menus to focus student activities.

+  Checks geometric properties to test hypotheses based on Euclid’s five postulates.
+ Hides objects used in constructions to reduce screen clutter.

- Differentiates objects through the use of paint-like color and line palettes.

« Computes a locus continuously.

«  INustrates the dynamic characteristics of figures through animation.

+ Allows the user to save drawings and macros to disk.

«  Opens geometry constructions created on the TI-92.

«  Provides one square meter of full-size work space, and prints the 8.5 by 11.0 inches (21.59 by
27.94 cm) drawing area.
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About this Guidebook

The Cabri Geometry II Guidebook contains user information about the Cabri Geometry II
software. It provides descriptions, procedures, illustrations, and examples for using the software
features on Macintosh computers, and Windows™ and MS-DOS®-based PCs.

»

Structure

Many of the procedures, illustrations, and examples are virtually the same for the different
computer types. Significant differences between the Macintosh, Windows, and DOS versions
are identified for your convenience.

Most of the illustrations are from the Macintosh version; several are from the Windows and
DOS versions. Due to space limitations, we could not show every illustration for each version.
Therefore, some illustrations in this guidebook may be slightly different on your computer.

Key names are shown in small capital letters such as CTRL for the Control key and ESC for the
Escape key. The RETURN key on the Macintosh and the ENTER key on the PC keyboard perform
the same function. In this guidebook, “Press ENTER” means to press either ENTER or RETURN.

The Cabri Geometry II Guidebook contains the following chapters and appendices:

»

Definitions

Chapter 1 describes the basic operations for using Cabri II, starting with checking system
requirements for installing the software, through constructing objects, to saving and printing a
construction file.

Chapter 2 describes the Cabri Il menus and provides step-by-step procedures for using them.

Chapters 3 through 13 describe the Cabri II tools and provide step-by-step procedures for
using them. Each chapter discusses a specific group of Cabri II tools.

The following definitions will help you in your understanding of this guidebook.

point When used as an instruction, point means to place the screen pointer on
top of the object you wish to select.

click Click means to press and release the mouse button quickly, usually when
pointing to a specific location

double-click Double-click means to click the mouse button twice in succession.

drag Drag means to point to the object you want to drag, press and hold the

mouse button to select the object, and move the screen pointer to a new
location. Release the mouse button to stop dragging.

modify When used as an instruction, modify means to change the appearance,

size, location, or orientation of the object.

marquee outline Marquee outline is the outline of an object in animated dots, similar to a

movie marquee.

marquee rectangle Marquee rectangle is the selection rectangle that appears when you drag

with the Pointer tool from an unoccupied location in the drawing window.
When you release the mouse button, objects that lie completely within
the rectangle are selected.

vi
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Chapter 1: Learning the Basics

This chapter provides descriptions and examples of basic operations in Cabri Geometry II.
Becoming familiar with these items will enhance your usage. Differences between the Macintosh,
Windows, and MS-DOS versions are explicitly described where applicable. For convenience, DOS
will be used in the remainder of this guidebook to mean MS-DOS.

The following topics are discussed:

FIRST STEPS

CONSTRUCTING OBJECTS

Checking system requirements
Installing Cabri Geometry Il
Starting Cabri Geometry I

Optimizing your Macintosh system
configuration

Changing your Macintosh system
configuration using Cabri Geometry I

Using Cabri Geometry Il on a network
The Cabri Geometry Il window
Accessing on-line help

About menus and toolboxes

Pointers that guide you
Creating and selecting points
Handling ambiguities

Determining dependent and independent
objects

Dragging

Using the Undo/Redo command
Deleting objects

Changing the appearance of objects
Labeling objects

Scrolling the drawing window

Saving and printing

Copying permitted provided Tl copyright notice is included
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First Steps

Checking system requirements

Macintosh

DOS

« Macintosh Classic or better.

« System 6.0 or later.

« 1 Mb available RAM for a Macintosh
Classic. (Memory requirements will be

greater for color or larger monitors than on
the Classic.)

« Hard disk with 1.2 Mb available for
program and demonstration files.

« DOS-compatible computers (PCs), 386 or
better, and running MS-DOS 3.3 or later.

« EGA, VGA, SVGA video adapter and a color
monitor.

« 3 Mb RAM (minimum) memory installed.

« Hard disk with 2.5 Mb available for
program and demonstration files.

« Mouse, or an equivalent pointing device.

Windows 3.1 Windows 95

« 386 PC or better required; 486DX « 386 PC or better required; 486DX
recommended. recommended.

« PC must be in 386-Enhanced mode with » VGA, SVGA video adapter and a color
Virtual Memory enabled. monitor.

« VGA, SVGA video adapter and a color e 6 Mb RAM (minimum) memory installed.
monitor.

* 6 Mb RAM (minimum) memory installed.

« 7 Mb available hard disk space for program,
demonstration files, and system extensions.

» Mouse, or an equivalent pointing device.

« 2 Mb available hard disk space for program
and demonstration files.

« Mouse, or an equivalent pointing device.

Installing Cabri Geometry Il

Macintosh DOS
1. Create a folder named Cabri Il on your hard 1. Insert the Cabri Geometry II DOS diskette
disk. in your floppy disk drive.

2. Insert the Cabri Geometry II Macintosh
diskette in your floppy disk drive.

3. Double-click on the Installer on the diskette
and follow the directions on the screen.

2. At the DOS prompt, enter:
A:\INSTALL or B: \INSTALL, and then
follow the screen prompts.

Windows 3.1

Windows 95

1. Insert the Cabri Geometry II for Windows
diskette #1 in your floppy disk drive.

2. From Program Manager, click on RUN and
enter A: \SETUP, and then follow the screen
prompts.

1. Insert the Cabri Geometry II for Windows
diskette #1 in your floppy disk drive.

2. Click on START/RUN and enter A: \SETUP,
and then follow the screen prompts.

Installing Cabri Geometry Il on a network

If you have purchased the network license for Cabri Geometry II, you may run the software on
your network. Use network procedures that are compatible with your network to install Cabri
Geometry II. See your Macintosh, Windows, or DOS User’s manual or your network
documentation for more information, if necessary.

Note: Cabri Geometry II is supplied on high-density diskettes. If your computer will not accept

these diskettes, call, 1-800-TI-CARES and a service representative will supply you with low density

diskettes.
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Installing Cabri Geometry Il on a network  (continued)

Macintosh and DOS

1. Install Cabri Geometry II on the network server using the instructions given on the previous
page.

2. Run the program from the server the first time, and enter the requested information.

3. To run Cabri Geometry II on each network client, go to the directory on the network server
where the Cabri Geometry II application is installed. Macintosh users may double-click on
the Cabri II icon; DOS users may run Cabri2.exe to start the program.

The procedure described below, for Windows users, allows multiple client computers to run Cabri
Geometry II using the application software installed on the network server. Each client computer
is provided with the necessary system files to run Cabri Geometry II and a shortcut icon that is
linked to the application file on the network server.

Windows 3.1 and Windows 95

1. Install Cabri Geometry II on the network server using the instructions given on the previous
page. In the Select Destination screen, you must select a directory that will be accessible from each
client computer on the network.

2. Temporarily copy setup.exe and setup.w02 from the installation diskettes to the same directory in
which you installed Cabri Geometry II in step 1.

3. On each network client, go to the directory on the network server that contains setup.exe and
double-click to on this file to run the setup program.

4. In the Select Destination Directory  screen, click on the Browse button and select the same directory
that you used in step 1. Make sure the correct directory is displayed at the top of the window.
You may edit the path, if necessary, and then click on OK. Ignore the message that the directory
already exists.

5. In the Select Components screen, deselect the first three components. The installation program
will determine if the fourth component is necessary for Windows 3.1x users.

6. When Cabri Geometry II has been installed on all client computers, delete the two files that
were temporarily copied to the network server in step 2.

Starting Cabri Geometry I

Macintosh DOS

You can use one of four methods to start the Type CABRI and press ENTER from the DOS
software on a Macintosh: prompt directory where the Cabri Geometry II

« Use Open in the Finder. files are located.

« Double-click on the Cabri Il icon. (Optional) Add the Cabri directory to your DOS
path to open Cabri Geometry II from any

« Double-click on any Cabri Geometry II directory.

construction file, tool configuration file, or
macro file.

« Drag and drop any construction file onto
the Cabrill icon (System 7 users only).

Windows

Double-click on the Cabrill icon.

e,

Calbri Il
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First Steps (Continued)

Optimizing your Macintosh system configuration

If you are starting Cabri Geometry II on a Macintosh for the first time, you may need to make some
adjustments to make Cabri Geometry II compatible with your Macintosh computer system
configuration.

Graphics intensive programs require a large amount of memory to operate. The amount of memory
required directly relates to the size of your monitor and to the number of colors chosen to
represent graphical elements. Cabri Geometry II may require more memory than other applications
due to its interactive nature. Cabri Geometry II can assist you in optimizing your system.

If you see a warning message from the Finder, you need to make some adjustments to your system
configuration. This message indicates the amount of memory needed to run Cabri Geometry II
efficiently on your computer with your current configuration.

Click the OK button to proceed (Cabri Geometry II does not start). Then close any applications or
windows that are currently open. This frees the memory that these applications are using.

To change the amount of memory allocated to Cabri Geometry II, first make sure the Cabrill icon is
selected. Then, from the Finder, select Get Info in the File menu. Once the Get Info window appears,
decrease the application memory size to a value that is compatible with your computer.

If you are using System 7, an optional method is to use Virtual Memory to increase the amount of
memory available to applications. See your Macintosh User’s manual for more information.

The previous dialog box indicates the amount of available memory on your computer. You may
also select About this Macintosh  in the Apple menu for the same information.

Changing your Macintosh system configuration using Cabri Il

If you open Cabri Geometry II and the memory allocation on your Macintosh is not optimal, the
following dialog box appears. We recommend that you allow Cabri Geometry II to select optimal
parameters for your system automatically or that you select them using the Manual button.

You may wish to quit and modify the settings yourself if you are familiar with the memory and
monitor control panels.

| The memory allocated to Cabri is not optimal and
* Cabri cannot work properly.

You can:

= Allow Cabri to determine optimal memory

and screen settings automatically -------- >

# Ohtain more information and determine
optimal settings manually -------——------- >

* Quit Cabri -——------------—--------—ooo oo >

If you select the Automatic button, Cabri Geometry II computes the optimal settings for your
computer and then quits. The number of colors may change in the process of optimizing your
configuration. Double-click on the Cabri Geometry II icon for the changes to be applied to Cabri
Geometry II.

If you select the Manual button, Cabri Geometry II continues to the optimization dialog box (see
example on the next page) that allows you to optimize your configuration as you want. Read the
items in the Current Settings field first, and then manipulate the other fields as described below the
example. (You can also access the following dialog box by pressing the OPTION key when starting
the software.)

1-4 Chapter 1: Learning the Basics Copying permitted provided TI copyright notice is included
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% Semi-Manual optimization of your configuration

- Current settings
= Your monitor is currently set with 256 colors

« 2016 K of memory are currently allocated to Cabri
sOptimize -y

# Colors

# Cabri needs at least 3050 K of memory to run
on this screen (1500 K in Black & White)

Cabri cannot run with these settings

,,,,, #%creen Colors ro MEMOIY SEHNG oo Cancel

1500 K < [EIIA|@ < 2477 K

Cabri cannot run with these settings

0

i

tUalues are subject to some inaeccuracy and given for information purpose only?

Status: The status indicates whether or not Cabri Geometry II can run with the
current settings.

# Screen Colors The number of colors used to display objects is directly related to the
amount of memory required to execute Cabri Geometry II. You can click
on the up or down arrow buttons in this field to change the number of
screen colors. Check the Status field to determine if these values are
acceptable. Click on OK to continue.

Memory Setting The amount of memory available and the number of colors displayed
determine the number of objects that can be constructed. You can click on
the up and down arrow buttons in this field to change the amount of
memory allocated to Cabri Geometry II. The value on the left indicates the
amount of memory required to run Cabri Geometry II on your computer in
black and white. The value on the right indicates the amount of memory
currently available on your computer. Check the Status field to determine if
these values are acceptable. Click on OK to continue.

# Objects The amount of memory available is directly related to the number of
objects that can be constructed. Click on this button to optimize the
number of objects that can be constructed. If memory is limited, Cabri
Geometry II will probably suggest that fewer colors be used to construct
more objects. For optimal performance, Cabri Geometry II attempts to
allocate enough memory to construct at least 300 objects.

# Colors The number of colors used to display objects is directly related to the
amount of memory required to execute Cabri Geometry II. Click on this
button to optimize the number of colors displayed. If you use other
applications regularly that require 256 colors, you may wish to optimize
the number of colors. Given limited memory, this decreases the number of
objects that you can construct.

Copying permitted provided TI copyright notice is included Chapter 1: Learning the Basics 1-5
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First Steps (Continued)

The Cabri Geometry Il window

The illustration below shows the Cabri Geometry II window. This window contains the essential
elements of the Cabri Geometry II software. A description of each element follows the illustration.

Note: The screen shown below illustrates the Macintosh version. Screens on Windows and DOS
systems are similar but slightly different.

Help Icon Toolbar
'é"enu —f—% File Edi{ Options &
ar -
NEE T EEEEE
Close —@ Figure BS| Zoom
Box @ i ~Box
. T
[-] S
[£] | |
| o]
Attribute
. Palette
Attribute /|
Icons IE
E C
WE (|
O] i
Drawing J
Window | [ Size
i NI W H] Box
Select, move, and manipulate objects. \
Scroll Bars
Help Window Pointer Message

Elements of the Cabri Geometry Il window

Drawing Window

Menu bar

Selection Pointer

This region is where you build geometric constructions.

The menu bar contains common graphic user interface menus for file

management and editing, together with Cabri Geometry II options.
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Toolbar

Attribute icons

Help Icon
(Macintosh)

Help menu option
(Windows, DOS)

Selection pointer

Close box

Zoom hox
(Macintosh, Windows)

Size box
(Macintosh, Windows)

Scroll bars
(Macintosh, Windows)

The toolbar contains tools for building constructions. Eleven toolboxes
reside on the toolbar (see illustration below). To access a toolbox, press
and hold the mouse button on the icon. The items in that toolbox
appear.

Pointer
Points
Lines
Curves
Construct
Transform
Macro

NEEE PR

Check Property
Measure
Display
Draw

The attribute icons are not displayed unless you select the Show Attributes
command in the Options menu on the menu bar. These allow you to
modify the appearance of objects. You can create an attribute palette
(tear-off menu) by dragging an icon from the attribute icons to the
drawing window.

Clicking on the help icon [?] creates a help window at the bottom of your
screen that contains useful help messages for each command. Clicking
on the (?] again removes the help window.

Clicking on the Help menu option and selecting Help or pressing the F1
key toggles the help window ON and OFF.

The selection pointer is the primary tool for selecting menus and
building constructions. The shape of the pointer changes according to its
current operation and location.

The close box closes the window and creates a dialog box that allows
you to save your work if you have not done so.

The zoom box toggles the size of the window between the current size
and the full screen size.

Dragging the size box to a new location resizes the drawing window.

Clicking in the scroll bars or on the scroll arrows moves the contents of
the drawing window vertically or horizontally.

Copying permitted provided Tl copyright notice is included
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First Steps (Continued)

About menus and toolboxes

Operations are grouped by type in the pull-down menus located on the menu bar and on the
toolbar. Once a tool is selected, it remains active until you select another tool. If the icon of the
tool you want is shown on the toolbar, select it by clicking once on the icon. Commands in the
menu bar must be selected each time they are used.

Descriptions of the Cabri Geometry II menus and toolboxes follow:

MENUS

Apple Apple menu items or the Cabri Geometry II logo screen.

(Macintosh only)

File Commands for opening, closing, saving, or printing constructions.

Edit Commands for selecting or copying objects, refreshing the drawing window,
or replaying constructions.

Options Commands for tool configurations, hide/show attributes, preferences, or
setting software defaults (Macintosh only).

Window Standard Windows display options.

(Windows)

Help Help options.

(Windows, DOS)

TOOLBOXES  Tools for ...

Pointer Selecting or for free-hand transformations.

Points Constructing points.

Lines Constructing linear objects.

Curves Constructing circles, arcs, or conics.

Construct Euclidean geometry constructions.

Transform Transformational geometry.

Macro Making macros. New macros become part of this toolbox.

Check Property Checking properties of constructions based on Euclidean geometry.
Measure Measurements or calculations.

Display Annotating your constructions or animating objects.

Draw Changing the appearance of objects or displaying the coordinate system.

1-8
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Accessing on-line help

Macintosh

DOS

» Access on-line help by clicking on the help
icon (2] in the menu bar of the Cabri
Geometry II drawing window.

« A window appears at the bottom of your
drawing that contains information about
the tool currently selected.

*  Select additional tools to see their help
information.

*  Remove the help window by clicking on
the help icon again or by clicking on the
close box in the help window.

* The close box appears when you click in
the help window.

Access on-line help by clicking on the
Help menu option in the menu bar of the
Cabri Geometry II drawing window and
selecting Help, or press F1.

A window appears at the bottom of your
drawing that contains information about
the tool currently selected.

Select additional tools to see their help
information.

Remove the help window by clicking on
the help icon again or by pressing F1.

Windows

»  Access on-line help by clicking on the
Help menu option in the menu bar of the
Cabri Geometry II drawing window and
selecting Help.

+ A window appears at the bottom of your
drawing that contains information about
the tool currently selected.

+ Select additional tools to see their help
information.

«  Remove the help window by clicking on
the help icon again.

Copying permitted provided Tl copyright notice is included
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Constructing Objects

Pointers that guide you

Several types of pointers exist to help guide you through your constructions. The pointers are
illustrated below.

Pointer Cursor looks like...

arrow [N The pointer is in the toolbar, menu bar, or
scroll bars.

cross hair The Pointer tool is active.

construction pencil ) A construction tool is active.

selection pencil o A construction tool is active and a point can
be placed on an object.

pointing hand N A point can be selected.

selection hand M An object is dependent or to show the
intermediate stage between selecting an
object and dragging.

dragging hand & An object can be moved.

open hand " The COMMAND key (Macintosh) or the CTRL
(DOS) is pressed.

grasping hand F The window can be scrolled using the
mouse.

magnifying glass @ An ambiguity exists.

I-beam ] Text or numbers can be entered or edited.

paint brush Y Color or attributes can be changed.

paint bucket o) An object can be filled with a pattern or
color.

crossed lines + The Comment option is active.

column width + The column width of the table can be

adjusted.

Creating and selecting point*s

All objects are constructed using one or more points. You create or select points when a tool is
active. In general, the order of operation is to select a construction tool from the toolbox, and then
to create or select the required points that define the tool.

A point is created by a single click of the mouse. You can create points in unoccupied space when
the construction pencil & cursor is visible. You can create a point on an object or at the intersection of
two objects when a cursor message appears and the pointer changes to the selection pencil & cursor.
The following examples illustrate how to create and select points.
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Example 1: Creating the perpendicular bisector of two
points

1. Select the Perpendicular Bisector tool from the Construct NMEEE RN
toolbox. :

2. Move the % to any place in the drawing window and click
(not hold down) once. B,

A flashing point appears on the window, indicating that
this point has been selected for the construction.

3. Move to another place and click again.

A second point appears as well as the perpendicular
bisector of the segment connecting these two points.
(Note: The segment does not appear.)

If the pointer is near a valid object, a cursor message is
displayed. In some cases, it is sufficient to select only
one object to define a construction, as the next example
demonstrates.

Example 2: Creating the perpendicular bisector of a side of
a triangle

1. Select Triangle from the Lines toolbox. o -] Az =] 2]#]

2. Move the ® to any place in the drawing window and -
click. Move to a second location and click, and then to a ®
third location and click.

A triangle appears in the drawing window with the three
points selected as vertices.

Note: Depending on the speed at which you constructed
these three points, the sides of the triangle might appear
during the construction. Try doing this slowly and watch
the triangle materialize.

3. Select Perpendicular Bisector from the Construct toolbox.
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Constructing Objects  (Continued)

4. Move the cursor as follows so that the message
Perpendicular bisector of this side of the triangle appears. perpendicular bidector of this side of the triangle

When the cursor is in unoccupied space in the drawing
window, the ® appears. Move the cursor near a side of
the triangle. The cursor changes from the ® to the  with
the message Perpendicular bisector of this side of the triangle

(If the cursor is near a vertex of the triangle, the cursor
message This point appears.)

Click once, and the perpendicular bisector of the side of
the triangle appears.

Handling ambiguities

When two or more objects simultaneously occur at the location of the pointer, the magnifying glass
@ cursor and the cursor message Which object? appear. Press and hold down the mouse to see the
options in a dialog box. Select an object by pointing to the appropriate choice in the box and
releasing the mouse.

When multiple objects are present, they are listed in the order in which they were created.
Selecting an object causes it to display in marquee outline. You can move (drag) it to a new
location if it is an independent object and the Pointer tool is selected. Click in unoccupied space to
deselect the object. If you are using a construction tool, the object is selected for the construction.

Determining dependent and independent objects

All objects are created using one or more points. The manner in which you create an object
determines whether it is dependent or independent of the object. This distinction becomes very
important with respect to dragging objects. An example of this distinction is given after the section
“Dragging.”

A point constructed by itself is called a basic point.

An independent object is an object created using only basic points. Independent objects can be
moved (dragged) but not modified directly. By moving the basic points used for their construction,
you can modify them indirectly.

A dependent object is an object constructed using an independent object (or another dependent
object). Dependent objects cannot be moved (dragged) or modified directly. You can move or
modify them indirectly by moving the basic points or independent objects responsible for their
existence.

The more elaborate a construction becomes, the more difficult it can be sometimes to distinguish
these types. However, the Cabri Geometry II software will assist you.
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Dragging

Dragging objects is valuable for generating conjectures. You can modify an object by dragging all
or part of it to a new location. Whether or not an object can be changed depends directly on how it
was created.

You can drag (move) a basic point to a new location, modifying, in turn, any object constructed
using it. An independent object can be modified with one of the tools from the Pointer toolbox. You
cannot alter a dependent object directly by dragging, but you can change it by dragging the basic
points used in its construction.

Whenever an object can be dragged, the pointer changes to the selection hand » momentarily and
then to the dragging hand €y cursor. When the €1 is visible, the selected object follows the pointer as
you move it.

If your computer's performance is sluggish, you may need to move the pointer to the location you
want and wait for the computations to finish with the new characteristics. This is particularly
evident when there are many objects in the drawing window.

If the object is dependent (cannot be dragged), the pointer changes to the selection hand  and then
reverts to the cross hair + cursor.

Example 3: Evaluating basic points, independent objects,
and dependent objects

1. Construct the perpendicular bisector of a side of a
triangle (see Example 2).

(The vertices are basic points, the triangle is an
independent object, and the perpendicular bisector is a
dependent object.)

2. Basic points:

Select Pointer from the Pointer toolbox. ||T | ol Mdedxd 4= eS|

Move the + near a vertex of the triangle (the cursor
changes to the {» with the message This point ).

Press and hold down the mouse button.

The cursor changes to the  and then almost

immediately to the €.
This point
When you drag the point, the triangle changes its size
and shape, and the perpendicular bisector changes
accordingly.
These results are characteristics of using a basic point.
An inquiry that could be made here is: “When does the
perpendicular bisector of one side of a triangle contain
a vertex of the triangle?”
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Constructing Objects  (Continued)

Independent objects:

Move the + near a side of the triangle (the cursor
changes to the ¥ with the message This triangle ).

Press and hold down the mouse button.

The cursor changes to the f, and then almost
immediately to the €.

Continue to hold down the mouse and move the triangle
about the drawing window.

The triangle does not change its size or its shape, while
the perpendicular bisector moves along with the triangle.
The triangle was constructed using three basic points as
its vertices; therefore, it is an independent object and
can be moved.

Dependent objects:

Move the + near the perpendicular bisector (the cursor
changes to the {» with the message This line).

Press and hold down the mouse button.

The cursor changes to the {, and then almost
immediately back to the +.

The perpendicular bisector cannot be modified directly;
it is a dependent object.

Note: You can modify the perpendicular bisector
indirectly by dragging the basic points or the
independent objects used for its creation.

Example 4: Creating the circumcenter of a triangle

Construct the perpendicular bisector of one side of a
triangle (see Example 2.)

Construct the perpendicular bisector of a second side.

This line
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3. Choose Intersection Point(s) from the Points toolbox. MEEEEEEEEELR

4. Point to one of the perpendicular bisectors (the cursor
message This line appears) and click once.

The line changes to marquee outline.

5. Point to the other perpendicular bisector. After the
cursor message appears, click once.

The first line returns to solid, and a point at the
intersection of the two lines appears. This point of ok
intersection is known as the circumcenter of the triangle.

This line

The vertices of the triangle are basic points. The triangle
is an independent object because its existence depends
only upon basic points. The perpendicular bisectors are
dependent objects because their existence depends upon
independent objects (the sides of the triangle). The
circumcenter is a dependent object because it was
created using dependent objects (the perpendicular
bisectors).

In Example 5, we will first create a circle, and then inscribe a triangle. You can move the circle by
dragging its center point or modify it by dragging its circumference. The triangle cannot be moved.
However, you can modify it by dragging any one of its vertices around the circle.

Example 5: Inscribing a triangle in a circle

1. Choose Circle from the Curves toolbox. DEEEFErEEELD

2. Move the ® to any place in the drawing window and click

once. @

A flashing point appears. B

3. Move the cursor away from the flashing point.
A circle appears with the flashing point as its center.
Click again to finish constructing the circle.

Note: The flashing point changes to solid to indicate the
construction is completed.
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Constructing Objects  (Continued)

4. Choose Triangle from the Lines toolbox. | N rEFEREEE ﬂl

5. Move the ® to any point of the circle (the cursor message On this circle
On this circle appears), and click once. @

6. Move the cursor to a second and third point on the

circle, clicking once at each point.
A triangle becomes inscribed in the circle.

7. Choose Pointer from the Pointer toolbox. "T o] Meyxd d=zq Afe

8. Move the + cursor near the center point (the cursor

message This point appears).

Press and hold down the mouse button until the €x

appears, and drag the center point around the drawing

window.

Note: The radius of the circle remains unchanged. v

9. Move the + near the circumference of the circle (the
cursor message This circle appears).

Press and hold down the mouse button until the €
appears, and drag the circumference.

Note: The center point of the circle remains fixed while
the radius changes, and the vertices of the triangle stay
on the circle.

10. Move the + near a vertex of the inscribed triangle (the
cursor message This point appears).
Press and hold down the mouse button until the €
appears, and then drag the point.

Note: The point can only be moved along the circle.

If you move the pointer while creating points, Cabri Geometry II reverts to dragging. This feature
anticipates your intent to modify your construction without requiring you to return to the Pointer
toolbox. However, it can create some confusion if you are creating points quickly and
inadvertently move the pointer while pressing the mouse. In this case, a point will not be created.
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Using the Undo/Redo command

You can cancel an operation that has just been completed by using the Undo/Redo command in the
Edit menu. Only the most recent operation can be undone.

To review additional steps in your construction, see the Replay Construction command in the Edit
menu. This command allows you to replay each step of a construction.

Deleting objects

Delete objects by selecting them, and then pressing DELETE or selecting the Clear command in the
Edit menu.

Select multiple objects by pressing the mouse in free space and dragging a marquee rectangle
around the objects to be deleted. Only objects that are fully enclosed by the marquee rectangle will
be deleted. All selected objects are displayed in marquee outline.

Select all objects in the drawing window by using the Select Al command in the Edit menu. Then
press DELETE or select Clear from the Edit menu. You can also clear the entire drawing window by
pressing COMMAND+A (Macintosh) or CTRL+A (Windows, DOS) simultaneously, releasing, then
pressing DELETE.

WARNING! When an object is deleted, all objects that depend on that object are deleted as well. It
is possible to delete an entire construction by deleting a single point. If you accidentally delete an
object, you can recover it by using the Undo/Redo command in the Edit menu.

Example 6a: Deleting objects — Method 1

1. Construct a circle and an inscribed triangle
(see Example 5).

2. Select Painter from the Pointer toolbox. |'|Ti IEEEEIEEED

3. Point to the center point of the circle and click.
The center point flashes.
Press the DELETE key. -

The point, the circle, and the triangle disappear.
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Constructing Objects  (Continued)

Example 6b: Deleting objects — Method 2

1. Repeat steps 1 and 2 in Method 1, or select Undo/Redo in KT This cirele
the Edit menu. : "

2. Point to the circle and click.
The circle appears in marquee outline.
Press the DELETE key.

The circle and the triangle disappear, but the center point
remains.

Example 6¢: Deleting objects — Method 3

1. Repeat steps 1 and 2 in Method 1, or select Undo/Redo .

J
b

2. Point to the triangle and click. b ‘}‘@Qg'e
Press the DELETE key. fooon o

The triangle disappears, but the circle, its center point,
and the vertices of the triangle remain.

Example 6d: Deleting objects — Method 4

1. Repeat steps 1 and 2 in Method 1, or select Undo/Redo .
2. Point to a vertex of the triangle and click.
Press the DELETE key.
What happened? How does this differ from Method 3? This point
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Changing the Appearance of Objects
You can change the appearance of objects from the Attributes toolbar or the Draw toolbox.

Access the Attributes toolbar from the Hide/Show Attributes command in the Options menu. In the Draw
toolbox, use the Fill, Thick, Dotted , or Modify Appearance tools.

To apply attributes from tools in the Draw menu, select the tool, and then select the object to be
modified. To use an option from the Attributes toolbar, first select the objects to be modified, and
then select the attribute.

Labeling objects
You can label points in two ways — as you create them or with the Label tool in the Display toolbox.

Labeling objects as they are created is intended for quick access and is limited to five
alphanumeric characters. Editing is not available at this stage. However, after constructing the
object, you can edit the label with the Label tool.

Example 7a: Adding labels during construction

1. Select Triangle from the Lines toolbox. M eEEERDREEEO
2. Click on the drawing window. Then type A. W
A point appears with a label A beside it. / """""""" '
B

3. Move the d, click once, and then type B.

Another point, a segment connecting the two points,
and a label B appear.

4. Move the d to a new position, click once, and type C.

The completed triangle appears as well as the label C
beside the last point created.

The Label tool in the Display toolbox allows you to attach labels to a point, line, or circle. Once
attached to the object, labels cannot be detached. You can position them near the object using the
Pointer , and they will retain that position through all modifications to the object.
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Constructing Objects  (Continued)

Example 7b: Adding labels after construction

1. Select Triangle from the Lines toolbox.

2. Construct a triangle on the drawing window.

3. Select Label from the Display toolbox.

4. Move the + near a vertex of the triangle.

The cursor changes to the I-beam I (the cursor message
This point appears).

5. Click once and an edit box appears.

Note: (Macintosh only) On the top row are four options
that generate pull-down menus: C for font character set,
S for font size, F for font style, and the last box for text
color.

6. Type a name for the vertex, and then click anywhere
outside the edit box.

The box disappears, but the name remains.

7. Repeat for the other vertices.

|ii _ﬁ_.-j el 1= _J.||!.|f||

EEEE R

TThs point

New York City

Los Angeles Miami

You can also apply comments to measurements immediately after creating them. Just begin typing

characters after creating the measurement.
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Example 8: Comments

1. Select Triangle from the Lines toolbox. MR EEFEECEEED

2. Construct a triangle and label its vertices A, B, and C.

3. Select Area from the Measure toolbox. |ﬂ IEE R _-.F'_‘ _4||§]|
A

4. Move the cursor to a side of the triangle until it changes
to the ¥ (the cursor message This triangle appears), and
click once.

triangle

Depending on the triangle and the default settings, a
number and units label, such as 4.520 cm2, appears. B C

5. Begin typing the comment Area of ABC = .

The comment attaches to the left side of the
measurement.

6. Select Comments from the Display toolbox. | MR EEE R IR m

7. Move the + near the area (the cursor message Edit this
text appears and the cursor changes to the I).

Click once and an edit box appears with the value of the

area and the comment entered in step 5 on the text line. /H\
8. Move the cursor between “of” and “ABC” in the text :
line, and add the word triangle . / Area of ABC 5.4.520 cm?
The text now reads “Area of triangle ABC = 4.520 cm 2.” B C
9. Click on the toolbar or press ESC to make the edit box A
disappear, leaving the comment on the drawing
window.
Area of triangle ABC = 4.520 cm?
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Constructing Objects  (Continued)

Scrolling the drawing window
You can scroll the drawing window within a one-square-meter region by three methods:

» Use the Show Drawing command in the File menu to view the entire one-square-meter region
in compressed form. You can reposition the active widow, which allows you to work in
another section of the drawing. (Note: When you click and hold the mouse button, the
grasping hand cursor (r) appears.)

» Use the scroll bars on the right and bottom sides of the drawing window (Macintosh only).
Clicking on the scroll bars or buttons moves the drawing in a horizontal or vertical direction.

» Press the COMMAND key (Macintosh) or the CTRL key (Windows, DOS), then press down on the
left mouse button. The screen scrolls in the direction that you move the pointer.

Saving and printing

You can save a construction to a file at any time using the Save and Save as... commands in the File
menu. If the construction has never been saved, these two commands have the same effect.

The Save dialog box allows you to name the construction and to choose the folder where it will be
stored. If the construction has already been saved, the Save command is active only if the figure
has been modified since the previous save. The new version of the construction replaces the older
one.

The Save as... command allows you to save the figure to another folder or name without deleting
the older version.

You can print your Cabri Geometry II constructions on a printer. Printed constructions enhance
understanding by providing accurate, printed-to-scale manipulatives. The entire one-square-meter
drawing or a specified portion can be printed in both black and white, or color.
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Chapter 2: Using the Menus

The Cabri Geometry Il menus contain standard graphic user interface functions for file
management and editing, plus options for Cabri Geometry II. They are located on the menu bar at
the top of the Cabri Geometry II window.

The following menu options are available. Each option is discussed in this chapter in detail
according to its order on the pull-down menus.

FILE MENU EDIT MENU OPTIONS MENU HELP
New Undo/Redo Show/Hide Help
Open... Cut Attributes (Windows, DOS)
1 .
Close! Copy Defaults... (Macintosh)
Save Paste Preferences... About (Cabiri Il...)
Tool
Save as... Clear Configuration...
Revert... ¢ Select all 5
Language
i 4 Select all
Show Drawing... Font5
Show Page... 3 Replay Sizes
Page S . Construction 1ze
age Setup...
Refresh Drawing Style®
Printer Setup... 2
Print...
Quit
Note: 'Macintosh only

2DOS only

3Windows only

“Macintosh, DOS only

®Macintosh, Windows only
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File Menu

The File menu contains commands that relate to opening, closing, saving, printing, and viewing
Cabri Geometry II constructions.

A description of each item in the File menu as it relates to Cabri Geometry II is given below.
Consult your Macintosh, Windows, or DOS User’s Guide for more information on the following
menu items: New, Open, Close, Save, Save as, Page/Printer Setup, Print, and Quit.

New

Keyboard shortcut: COMMAND+N (Macintosh); CTRL+N (Windows, DOS)

The New command opens a new, blank Cabri Geometry II drawing window. For the Macintosh and
Windows versions, the window appears on top of all other windows and is the active window. The
window is not assigned a name until you save it using Save or Save as. For the DOS version, only
one drawing window at a time is displayed. Therefore, you are prompted to save your current
drawing before the new drawing window takes effect.

Open...
Keyboard shortcut:  COMMAND+O (Macintosh); CTRL+0 (Windows, DOS)

The Open command generates a dialog box for opening an existing construction file, macro, tool
configuration file, preference file, or TI-92 file. Use the dialog box to specify the folder and file to
open.

A construction file is displayed with the view that was visible when the file was last saved. You can
view a summary of the steps used to create the construction interactively by selecting Replay
Construction in the Edit menu.

A macro appears in the Macro toolbox and may be used immediately in the construction.

A tool configuration file immediately alters the Cabri Geometry II tool configuration as defined in
the file. See Tool Configuration in the Options menu for more information.

A preference file immediately alters Cabri Geometry II preferences as defined in the file. See
Preferences in the Options menu for more information.

Close

Keyboard shortcut: COMMAND+W. You also can click in the close box, located on the top left-hand
side of the active window in the title bar.

The Close command (Macintosh, Windows) closes the active drawing window. If changes were
made to the construction file, the Close dialog box appears and provides the option to save the
changes. If the file is new, the dialog changes to the Save dialog box. Cabri Geometry II is still
active in your computer's memory after all files have been closed and does not free memory for
applications other than Cabri Geometry II.

Save
Keyboard shortcut: COMMAND+S (Macintosh); CTRL+S (Windows, DOS)

The Save command saves the construction in the active drawing window to the file name specified
previously. The Save as dialog box appears if the file was not saved previously. The construction
remains open and active after saving,.

The current view of a construction is saved with the file so that it opens to the same view when
reopened. Any macros used in the construction are automatically saved with the file and are
available for use in future edit sessions with the saved file.
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Save as...

The Save as... command generates a dialog box for saving and naming the construction in the active
drawing window. The Save as dialog box provides the interface for saving a new file, saving a file to
a new file name, file type, or location, or saving an existing file. Enter the information requested in
the dialog box to save the file.

For the Macintosh only, you can save the file as a text file if you wish to view its contents with
another program. For example, you can copy data in the Cabri Geometry II table to word
processing or spreadsheet files for further analysis using this method.

Revert...

The Revert... command returns the construction to its most recently saved version. This feature is
useful if you make modifications to your file that you later want to disregard. Revert is especially
useful when demonstrating a construction in the classroom.

Show Drawing... (Macintosh, DOS), Show Page... (Windows)

The size of the drawing window in which you build a geometric construction is one meter by one
meter. Show Drawing/Show Page lets you view this entire region. The entire figure, with the exception
of text or measurement, is displayed in the following dialog box shown below.

A small window represents the portion of your construction that is visible on your computer
screen. The construction cannot be manipulated at this stage, but you can position the window
anywhere within the one-square-meter limits of the construction. Drag the window to move it to
a new section of your construction. Click OK or Cancel to accept or cancel the operation.

» For the Macintosh, the visible part of your construction can also be moved by clicking on the
scroll bars or by dragging the drawing window while pressing the COMMAND key. Pressing the
COMMAND key changes the pointer to the open hand " cursor; pressing the mouse button and
the COMMAND key changes the pointer to the grasping hand 17 cursor. You can perform either
method without accessing the Show Drawing/Show Page command.

» For the DOS versions, the visible part of your construction can also be moved by dragging the
drawing window with the grasping hand 1> cursor. Moving the pointer to the drawing window
changes the pointer to the open hand " cursor; pressing the left mouse button changes the
pointer to the grasping hand i cursor. You can perform either method without accessing the
Show Drawing/Show Page command.

» For the Windows version, the visible part of your construction can be moved by also clicking
on and then dragging the drawing window.

Page Setup... (Macintosh, Windows)

The Page Setup... command lets you specify the paper size and orientation (landscape or portrait),
as well as other options that vary according to the printer.

Note: Cabri Geometry II prints figures to scale. That is, a triangle in your construction will be
printed exactly as specified, preserving the length of the sides and the measurement of the angles.
If you change the Reduce or Enlarge option from 100%, the exact size of the figure will not be
preserved.
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File Menu (Continued)

Print... (Macintosh, Windows)

The Print command for the Macintosh and Windows versions opens a dialog box that provides
several options for printing your construction. After specifying the options you want in Page Setup
and Print, click the Print button to send your construction to the printer.

The Placement options... (Macintosh only) lets you position your construction as it will appear on a
printed page by dragging the clear page in the screen. The drawing window (your computer
screen) is shown for a reference. Select Print labels in ltalics  to automatically print all labels in italic
font.

If your construction requires more than one page, select the Posterize option (Macintosh only) to
number each page. You can select the position of the pages by using the pointer to drag the center
page (outlined with bold lines) in the drawing region. You can change the number of pages by
dragging the boxes in the upper-left and lower-right corners of the print region. This option makes
it fun to create very large drawings, which can be taped together.

Printer Setup... (DOS)

The Printer Setup... command for the DOS version lets you select a printer and respective print
quality, and to specify the page size (US Letter, US Legal, or A4 Letter) and orientation (portrait or
landscape). Click on the selections to see the menu options.

The Printer option lets you select one of the printers listed below. If your specific printer is not in
this list, select a printer that may be similar. (Note: The print quality setting that you select may
affect the throughput of your printer. Allow ample time for high quality printer settings.)

- IBM/Epson 9 pin *  DesklJet 500C (CYM)
- IBM/Epson 24 pin *  DesklJet 500C (RGB)
«  Epson Stylus Color + LaserJet HP

e DesklJet 500 *  Proprinter XL

Print... (DOS)

The size of the drawing window in which you build a geometric construction is one meter by one
meter. Print lets you view this entire region before printing your construction. The entire figure,
with the exception of text or measurement, is displayed.

A small window represents the portion of your construction that will be printed. The construction
cannot be manipulated at this stage, but you can position the window anywhere within the one-
square-meter limits of the construction. Drag the window to move it to a new section of your
construction. Click OK or Cancel to accept or cancel the operation. Clicking on OK sends the screen
image to your printer.

Quit
Keyboard shortcut:  COMMAND+Q (Macintosh); CTRL+Q (Windows, DOS)

The Quit command closes all open files and quits Cabri Geometry II. It gives you the opportunity to
save changed or unsaved files.
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Edit Menu

The Edit menu contains commands that relate to modifying the construction sequence, commands
for exporting items in the drawing to the clipboard, and commands for selecting and deleting items
in the drawing.

Undo/Redo
Keyboard shortcut:  COMMAND+Z (Macintosh) or CTRL+Z (Windows, DOS)

The Undo/Redo command lets you undo the previous action or redo the undone action. These
commands have a recall of one action only. If you wish to review additional action steps, see Replay
Construction on the next page.

The Windows version has an option in the Options/Preferences menu to let you disable the Undo
command. Disabling Undo provides for faster manipulation of very large and complex figures.

Cut/Copy/Paste

For the Macintosh and Windows versions, the Cut, Copy, and Paste commands use the
Macintosh/Windows clipboard to import and export selected items to and from a construction. For
the DOS version, these edit commands use a custom Cabri Geometry II clipboard.

Cut removes the selection from the construction and places it on the clipboard (Macintosh,
Windows), or in the file $CLIPCAB.FIG (DOS).

Copy places the selected objects on the clipboard without removing them from the construction.
Additionally, for the DOS version, the selection is saved to a file depending on the type of items
that are selected. Copying a construction creates two files $CLIPCAB.BMP and $CLIPCAB.FIG.
Copying a table that contains data creates the file $CLIPCAB.TXT. Therefore, to copy and paste a
construction or table into another application, such as a word processor or spreadsheet, when
using the DOS version, select the objects and click on Copy. Then open the other application and
insert the appropriate .BMP, .FIG, or .TXT file to the desired location.

Paste copies the objects from the clipboard into the drawing window that is active. After pasting,
the clipboard still contains the objects. Therefore, you can paste them in another location or Cabri
file, if you desire. In general, objects can be pasted as many times as available memory allows. One
exception is copying the table. Because Cabri Geometry II defines only a single table and the
contents of a table are dependent upon other objects, Cabri Geometry II cannot duplicate the table
within the software. Further, only the contents of the table (the numerical values) are copied to
another application.

Objects are pasted in the same position in which they were copied. If you are pasting to the same
Cabri Geometry II drawing from which you cut or copied the objects, they are pasted in the same
position but with a small offset in location. The pasted objects are independent of the objects from
which they were cut or copied.

Keyboard shortcuts: COMMAND+X (Macintosh) or CTRL+X (Windows, DOS) for Cut, COMMAND+C
(Macintosh) or CTRL+C (Windows, DOS) for Copy, and COMMAND+V (Macintosh) or CTRL+V
(Windows, DOS) for Paste.

Clear

The Clear command removes selected objects from the construction. This command is equivalent
to pressing the DELETE key. Objects are not placed on the clipboard.
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Edit Menu (Continued)

Select all
Keyboard shortcut: COMMAND+A (Macintosh) or CTRL+A (DOS)

The Select all command selects every object in a construction. Using Select all and then Clear is an
easy way to erase the contents of a construction to start again with a clean drawing.

Replay Construction

The Replay Construction command for the Macintosh and Windows versions replays each step of a
construction. You may stop the replay at any step in the construction and begin editing. If you stop
the replay before the end of the construction is reached and begin to edit, all subsequent steps in
the original construction are nullified. A floating toolbar is generated when this command is
selected. Note that the Macintosh version provides several additional buttons.

Macintosh

Stop Fast Pause Fast Continuous
\ Foward Reverse

|
—_—
] e < [ m o] 21T

Begin Reverse Forward End

Windows

Replay Construction

1 |F’DiTt first object construé\id in the figure) /
Button

descriptions |« | <« | > |
Cancel |

The Replay Construction command for the DOS version replays each step of a construction when you
press the left and right arrow keys on the keyboard. Pressing the right arrow key replays the
construction in the forward direction and pressing the left arrow key replays the construction in
the reverse direction. Unlike the Macintosh and Windows versions, you cannot edit a construction
if you stop the replay before you reach the end of the construction. When you click the mouse at
any point during the replay, the entire construction is displayed.

Refresh Drawing
Keyboard Shortcut:  COMMAND+F (Macintosh) or CTRL+F (Windows, DOS)

The Refresh Drawing command redraws every object of a construction. In the process of redrawing,
undefined elements are removed. Pixels turned on by Trace are removed in this manner.

(Macintosh, Windows) An alternative method for redrawing the construction is to click on the
zoom box in the top right corner of the drawing window. This action also causes the window to
expand to its logical maximum size. Clicking the box again causes the window to shrink back to its
previous size.
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Options Menu

The Options menu contains commands that relate to showing attributes of each construction tool,
setting defaults, and defining the contents and configuration of the toolbar.

Hide/Show Attributes

The Hide/Show Attributes command hides and shows the attributes toolbar. You can toggle the
command from one to the other.

Defaults... (Macintosh only)

The Defaults... command for the Macintosh version provides options that allow you to select default
colors and attribute settings for various classes of objects. The defaults can be saved to the Cabri
Geometry II preference file. If the Cabri Geometry II preference file is placed in the Cabri
Geometry II preferences folder or the system preferences folder, the settings saved in this file will
be activated each time you open Cabri Geometry II. The Default Options dialog box is shown
below. Click the Factory Settings button to return each default to its factory specification.

B Taiill Opbisas
Defaull Calows AbEimete SE1ings
Feui i | . -|.-| TRiCE S '-|
Lines: E Lmial Bais |j
Felggonn: | - - | Large Oalx | '-'I
1L BT 4! E Painis Typas: E
Cirles Conics: | BN = | Angle karks; [ L =]
Liogic | | B | Tuisill | T '||r|
LT [ ~]
Eamdv: E
Rids: IEI [ rmam oh jecis &l infiniby
ngie arks: [ T v
[ e 10 file
Faclary Seilings '| I Tancel | Epply in l.: :I:II:II ?IEJ:"‘

Preferences...

The Preferences... command lets you specify particular aspects of the program related to loci, the
coordinate system, measurements, and equation formats. A dialog box, as shown on the next page,
appears when you select this command. The options are described below the illustration.

The settings specified in Preferences for the Macintosh and Windows versions can be saved to a
Cabri Geometry II preferences file. This file also contains the defaults specified using the Defaults
command. This file must reside in the Cabri Geometry II preferences folder or your Macintosh
system preferences folder for it to be automatically referenced at run time. If more than one Cabri
Geometry II preferences file is in either of these folders, Cabri Geometry II will use the first file
that it finds. The Cabri Geometry II preferences file and preferences folder are created when a
preference file or tool configuration file is saved to disk for the first time.

This menu option in the DOS version is very similar to the Macintosh version. However, only one
preference file (cabri2.prf) can exist in the same subdirectory. Additionally, when you select
Preferences and save to a file, the new preferences will be used when you start Cabri Geometry II
the next time. To change preferences, go back to Preferences and change the settings or set them
back to Factory Settings .
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Options Menu  (Continued)

Macintosh, DOS

Windows

FrE e e W pes

Preferences H

Loci epEians

rember | W
Locus of lmes =[5 Cnsaloge

Nizplaged Precivan

Lemgh B.00 fmim *
Ll | ! ¥ |
iher | ! |
DedwlE Mniiln

e
b

|. lFeclary B=llEngs

ramider af ahjjecis iniocos - ET
I —

Loiiis &1 painis | 5 Lek goisls

O Presssvision ki (DOS onIy)

Ceardinale fgul=m |

Loci optiohg ] Drefault Styles ] Geometry ] Syztem options ]

|_:-j;|-.u.|.“ - | Display Precision and units | Coordinate System and equations ]
Number of decimal digits Units
Fuafian Foemais Length n Centimeter [cm] n
An
N —
Lirrle [TLE] ..-";-uq.._-u--| g 0 n
L onic | |":5"f‘-|7;_="|l"|| I|l|

O Selection
New Objects

Factory Settings

[] Sause i dibe O Feep as defaults

(v [ o

. W o Objerbs
|_Eancul 0 S b i il

Loci options

Coordinate System

Displayed Precision

Default Units

Equation Formats

Presentation Font

This option applies to all loci constructed in the drawing.

The Locus tool performs a linear interpolation of the loci calculated.
Therefore, the more objects in the locus, the smoother it will appear. You
can change this number in this dialog box for the default setting or for a
specific locus by selecting the locus, and then changing the values in this
dialog. You can also change the number of objects in the locus by selecting
the locus, and then pressing + or — on the keyboard to increase or
decrease the number of objects.

Selecting the Link points option connects adjacent points with a solid line.

Selecting the Envelope option draws only the envelope of a line as the locus
rather than the locus of the line.

The default coordinate system can be set up for Cartesian or polar
coordinates.

Select the precision of the units displayed. Cabri Geometry II always uses
the maximum precision of the Macintosh when measuring objects. You
can display additional precision by using Numerical Edit in the Display
toolbox.

Select the units you want when measuring objects. The default unit for
length also specifies the unit for area.

Select the equation formats you desire from the option listed for lines,
circles, and conics. Some formats for conics may not be possible for all
conics that can be constructed.

This DOS-version option doubles the size of the text font for readability
(e.g., for presentations).

Keyboard shortcut: CTRL+D
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Geometry This Windows-version option lets you select if points should be implicitly
defined, and if objects should be drawn to infinity.

Default Styles This Windows-version option lets you choose colors and font options for
all toolbar commands.

System options This Windows-version option lets you set the following:

» Bitmap Copy: U Enhanced MetaFile format (EMF) for 32-bit versions of
Windows for high-quality, smooth lines. ¥ Supports only bit-mapped
format (BMP), which is optional for Windows 95 and required for
Windows 3.1x.

»  System Pallet: Defines the color palette to use when Cabri is in the
background and the palette is changed by another application. 0 Cabri
colors will change when another option is brought to the foreground.
W Cabri uses only colors present in the default system palette.

» Disable Undo: O Undo is enabled. ¥ Undo is disabled, which provides for
faster manipulation of very large and complex figures.

»  Cursor Font: Lets you define the display font to use for display
indicators.

» Menu Font: Lets you define the display font to use for menu options.

Tool Configuration...

The Tool Configuration... command allows teachers to configure Cabri Geometry II tools in the
toolbar to the aptitude of their class. You can rearrange or remove any tool in the toolbar. You can
place a tool configuration file in the preferences folder to automatically open Cabri Geometry II
with the tool configuration specified in that file. The following steps show you how to customize
your toolbar.

1. Select Tool Configuration in the Options menu.
2. To remove any tool from its current toolbox, select the tool.
The tool becomes attached to the pointer.
3. To relocate the attached tool to an existing toolbox, open any toolbox.

The relocated tool is inserted immediately below a tool that you highlighted with the cursor.
The tool will be copied to the top of the toolbox if you do not highlight another tool.

4. To relocate the attached tool in a new toolbox, click in any empty section of the toolbar. To
remove the tool from the toolbar, click on the toolbar trash can.

5. To add spaces between a toolbox or tool, press the spacebar while pressing and holding the
mouse button down. You can add up to five spaces between toolboxes or tools.

To remove spaces between a toolbox or tool, press the BACKSPACE key while pressing and
holding the mouse button down.

6. Add apassword to prevent the tool configuration from being changed inadvertently.

7. Save your new tool configuration. If you save it to a tool configuration file, you can use the
same configuration in future sessions of Cabri Geometry II. Otherwise, the configuration is
only valid for the current session. If you want to return the tool configuration back to the
factory configuration, click on the Factory Settings button.
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Options Menu  (Continued)

Languages (Macintosh, Windows)

The Languages command lets you change the language of Cabri Geometry II menus, dialog boxes,
messages, and labels. You may change the language at any time during a session.

Macintosh Windows
« 3 English Open a Language File [ 7] %]

11 French ] =

™ German Look in |Cabr| M e E

= Spanish (1 Fiquies
(7 tacras

Language settings... [ Deutchcg

guag g [ Eng-GE.col

[ English.cal
[#E spanal.cal
[ Francais.cal
[ ltalisno.cgl
File name: | I Open |
Files of type: |Language Files (“~CGL) M

The Language settings command opens a dialog box that lets you:
» Choose the language to be used the next time you start Cabri Geometry II.

» (Macintosh only) Choose to attach a language to the Cabri Geometry II software. Cabri
Geometry II can recognize any language module that is in the same folder. This command
integrates the language as part of the Cabri Geometry II software.

» (Macintosh only) Choose to exclude a language from the Cabri Geometry II software.

« Ifthe Andsave in afile option is selected, the language will be saved in a separate file and can
be reattached later.

« Ifthe And save in afile option is not selected, the language will not be available unless you
reinstall the software (for core languages) or place a language file in your Cabri folder.

1L i i e i

Therk ar moheck fhe lmguege iy gao want 1o

= Rpaf widh: I-""!C I.||!l1l| - I

® Includs 1o Cabei: | Melhing in @, v §
= Peclede from Cabei: ! = LD gk ""I

] Pl waise o & dile

.|H|I.'|'|
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Font (Macintosh, Windows)

The Font command in the Macintosh and Windows versions lets you view the fonts installed on
your computer. The v symbol in the Macintosh version is shown next to the default font. The
default font applies to labels, comments, numerical values, and properties. You can specify fonts
independently for the Label, Comments , or Numerical Edit tools by first selecting the tool, and then
changing the font in this menu. Point to another font to select it as the new default font.

Note: The Windows version dialog box lets you set the font size and style.

Size (Macintosh)

The Size command in the Macintosh version lets you view the font sizes available on your
computer. The point sizes in outlined text are sizes that your Macintosh should display without
distortion. The v symbol is shown next to the default size. The default size applies to labels,
comments, numerical values, and properties. You can specify size independently for the Label,
Comments , or Numerical Edit tools by first selecting the tool, and then changing the size in this menu.
Point to another size to select it as the new size. For classroom demonstrations, it is useful to set
the default font size at 14 or 18 points.

Style (Macintosh)

The Style command in the Macintosh version lets you view the text styles available on your
computer. Text styles are independently applied to text and may be combined. For example, you
can specify bold-italic text by selecting each style type separately. The default style applies to
labels, comments, numerical values, and properties. You can specify style independently for the
Label, Comments , or Numerical Edit tools by first selecting the tool, and then changing the style in this
menu.
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Help Menu (windows and DOS), [2J (Macintosh)

The Help menu in the Windows and DOS versions, and [?2] in the Macintosh version, let you view
helpful information about each toolbar icon and information about the Cabri Geometry II software.

Help
Keyboard shortcut:  F1 (DOS)

The Help command displays a description of the selected toolbar icon in the Help window at the
bottom of the Cabri Geometry II screen. For the Macintosh version, click on [?] to open the Help
window.

About (Cabri II)

The About (Cabri ll) command displays information about Cabri Geometry II that includes authors’
names, copyright notice, and the version number of the software.
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Chapter 3: Using the Pointer Toolbox

The Pointer toolbox contains the tools associated with Cabri Geometry II pointer features. These
features allow you to select objects and to perform freehand transformations.

The illustration below shows the location of the Pointer toolbox on the Cabri Geometry II toolbar,
along with its pull-down menu. Procedures for using Pointer tools, including examples, are
presented in this chapter in the order in which the tools appear on the pull-down menu.

Pointer toolbox

A A ] e A2

v
Pointer k
Rotate A k.!
IE- k. |
Dilate E
T Ty
)
Rotate and Dilate
.eh .
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h: Pointer

The Pointer tool selects or moves objects in a freehand manner.

Press and hold the mouse button in unoccupied space to observe all basic and independent points
which display as flashing. You can also double-click on a label, comment, numerical value, or the
table to automatically invoke the appropriate edit tool for the object.

Selecting or moving objects

1. Select Pointer from the Pointer toolbox. HT] A MR 1= _4||||rﬂ

2. Selecting: Select an object by pointing and clicking Point.

when the cursor message appears for that object.
This triangle

Select multiple objects by pressing the SHIFT key
when selecting objects, or by enclosing them in a
marquee rectangle as shown in the example below.

Deselect an object by pointing to an unoccupied .
location and clicking. Click to select.

?‘\_\_‘

Moving: Move an object by dragging it to a new .
location. Pt

Note: Sometimes multiple objects cannot be moved
concurrently. Dependent objects cannot be moved
directly. If a selected object cannot be moved
directly, the cursor reverts to the cross hair + instead T, This triangle
of the dragging hand €\ cursor. -

Point.

Drag.

Example

Selecting multiple objects using a marquee rectangle:

Drag marquee % &7 : Release mouse
rectangle : : button to select .
around objects. objects. y
i m
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L

1| Rotate

The Rotate tool rotates an object about its geometric center or about a defined point in a freehand
manner.

Rotating objects

1. Select Rotate from the Pointer toolbox. CHEREEEEREERED

2. Rotating about the geometric center: Select an object Drag object in a circular path.
(not a point), and drag it in a circular motion.

Note: Pressing the SHIFT key while dragging rotates
the object in 15-degree increments.

Rotating about a defined point: Select a desired

rotation point, and drag the object around the point.
Select a rotation point.
Deselect the rotation point by clicking once in free

space.

Note: You can rotate an object automatically by using

the Animation tool when the Rotate tool is visible on the

toolbar. See the chapter “Using the Display Toolbox”

for more information about Animation. ey This point

Drag object in a circular path.
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E Dilate

The Dilate tool expands or contracts an object about its geometric center or relative to a defined
point in a freehand manner.

Dilating objects
1. Select Dilate from the Pointer toolbox. @ BREEEEEEEEED

2. Dilating about the geometric center: Select an object Drag object along a linear path.
(not a point), and drag it away from its center to
expand, or toward its center to contract.

Note: Dragging an object through its center causes a
negative dilation.

Dilating about a defined point: Select a desired
dilation point, and drag the object (not the point) in
a linear motion.

Select a dilation point.

Note: You can dilate an object automatically by using %This point

the Animation tool when the Dilate tool is visible on the

toolbar. See the chapter “Using the Display Toolbox”

for more information about Animation . Drag object along a linear path.

q;l.
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Rotate and Dilate

The Rotate and Dilate tool rotates and dilates an object about its geometric center or a defined point
in a freehand manner. See the Rotate tool and the Dilate tool for more information.

Using Rotate and Dilate
Select Rotate and Dilate from the Pointer toolbox. ] el &l 2dxd 1z e

Note: You can rotate and dilate an object automatically by
using the Animation tool when the Rotate and Dilate tool is
visible on the toolbar. See the chapter “Using the Display
Toolbox” for more information about Animation.

Examples

Freehand rotation and dilation of an object about its
geometric center:

Drag object in a circular or linear path.

Freehand rotation and dilation of an object about a

defined point:
Select a transformation point. Drag object in a circular or linear path.
4‘L';his point D
A
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Chapter 4: Using the Points Toolbox

The Points toolbox contains the tools associated with creating or constructing points in Cabri
Geometry II. These features allow you to create points anywhere in the plane, on objects, or at the
intersection of two objects.

The illustration below shows the location of the Points toolbox on the Cabri Geometry II toolbar,
along with its pull-down menu. Procedures for using tools in the Points toolbox, including
examples, are presented in this chapter in the order in which the tools appear on the pull-down
menu.

Points toolbox

h [ A x| e A2

v
Point
Point on Object (
Intersection Point(s) ,_‘:—‘
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= | Point

The Point tool creates points that can be placed anywhere in the plane, on existing objects, or at the
intersection of any two objects.

If you create a point on an object, it remains on that object throughout any changes made to the
point or to the object. If a point is at the intersection of two objects, the point remains at the
intersection throughout any changes made to the object(s). If you change the objects so that they
no longer intersect, the intersection point disappears, but reappears if the objects intersect again.

Creating a point

1. Select Point from the Points toolbox. x| A M= 12 s
2. Move the cursor to any location in the plane where Create points in free space.

you want a point. When the cursor message appears, .

click once to create a point. If in free space, a cursor .,

message does not appear. B

Note: You do not have to select the Point on Object or
Intersection Point(s) tools to create a point on an object

. . Create points on objects
or at an intersection.

Create points at intersections.

A
¥ Point at thi$ intersection

Modifying a point
Move a point by dragging it to a new location. Point types toolbar.
You can change the appearance of points using: |_":|LILILI

» the Defaults option under the Options menu
(Macintosh only).

» the Attributes toolbar under the Options menu.
» the Modify Appearance option in the Draw toolbox.
You can construct a pointasa-, ¢, ®, x, oro.

Refer to the chapters “Using the Menus” and “Using the
Draw Toolbox” for these features.
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{ Point on Object

The Point on Object tool creates points on any object.

Creating a point on an object

1. Select Point on Object from the Points toolbox. | L inEl

s ERIEEEE ||

2. Move the cursor toward the object until a cursor
message appears for that object, and then click once.

Point.

w polygon

Click.
Modifying a point on an object
Move a point by dragging it to a new location. The point
always remains on the object.
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Intersection Point(s)

The Intersection Point(s) tool creates a point at the intersection (or intersections) of any two objects.

An intersection can be defined for only two objects. If more than two objects intersect at the same
place (for example, the perpendicular bisectors of a triangle), an ambiguity message appears. If
this happens, hold down the mouse button and select the correct object from the list.

If you change the objects so that they no longer intersect, the intersection point(s) disappears, but
reappears if the objects intersect again.

Creating an intersection point

1. Select Intersection Point(s) from the Points toolbox. | NMiEEEREEEEERE

2. Select two intersecting objects.

Points are created
Select the first object. Select the second object. at each intersection.

T
-
-
"
1
'

Modifying an intersection point

Intersection points are dependent and cannot be moved.

Example

Intersection of a line and a polygon:

Select polygon and line. Points are created at each
intersection.
. Thi% line
el 4
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Chapter 5: Using the Lines Toolbox

The Lines toolbox contains the tools associated with line features in Cabri Geometry II. These
features allow you to construct linear objects and polygons.

The illustration below shows the location of the Lines toolbox on the Cabri Geometry II toolbar,
along with its pull-down menu. Procedures for using tools in the Lines toolbox, including examples,
are presented in this chapter in the order in which the tools appear on the pull-down menu.

Defined objects in Cabri Geometry II, such as triangles and polygons, can be translated, rotated, or
dilated. Refer to the chapters “Using the Pointer Toolbox” and “Using the Transform Toolbox” for
more information about these methods.

Lines toolbox

| O %] 2e] A

v
Line _,-r"'"_-
Segment —
Ray -
Vector -
Triangle ;l""-;
Polygon 1"'-?.:

-

Regular L)
Polygon —
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| Line

The Line tool creates a line that extends infinitely in both directions through a point at a specified
slope. The slope can be specified in free space or defined by a second point.

Note: You can constrain the slope to 15-degree increments by pressing the SHIFT key when
creating or modifying a line.

Creating a line

1. Select Line from the Lines toolbox. | w P el &

~dxd 1424 ale]

2. Click to create or select the initial point of the line. Create a point.

P

Specify the slope.

3. Specify the slope by positioning the line in the
desired orientation and clicking.

When specifying slope, you can create a point on an
object, select an existing point, or click in
unoccupied space.

Modifying a line

Translate a line without changing the slope by selecting
the Pointer tool from the Pointer toolbox. Then using the
Pointer :

» For aline constructed with a single point, drag
the point.

» For aline constructed with two basic points, grab
the line away from the points, and drag.

Note: A line constructed with at least one dependent
point (a point attached to another object) cannot be
moved using the Pointer without changing the slope.
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Change the slope of a line by selecting the Pointer tool.
Then using the Pointer :

» To change a line constructed with a single point,
grab the line away from the point and drag. Press
the SHIFT key to constrain the slope to 15-degree
increments.

» To change a line constructed with two basic
points, drag either of the points.

» Changing a line constructed with a dependent
point is relative to the object to which it is
attached. You may drag the object or the point,
depending on the construction.

Example
The line is attached to a side of the
Create a point. Create a point. triangle and the opposite vertex.
Copying permitted provided Tl copyright notice is included Chapter 5: Using the Lines Toolbox 5-3

© 1997, 1999 Texas Instruments Incorporated



-
The Segment tool creates a segment between two endpoints.
Note: You can limit the slope of the segment to 15-degree increments by pressing the SHIFT key
when creating the segment.
Creating a segment
1. Select Segment from the Lines toolbox. |ﬂ J|_|_.i M ne] 1] e ||
2. Click to create or select the initial endpoint of the Create the initial point.
segment.
/ B
3. Move the pointer to the location for the final Create the final point.
endpoint of the segment, and click to create or select
the final endpoint. /
Example
Select the initial point. Point to the object. Create the final point.
Note: See “Regular Polygon” in this chapter for more information on creating the regular pentagon
in the above figures.
Modifying a segment
Change a segment by dragging either endpoint.
Translate a segment by grabbing away from the
endpoints, and dragging it.
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| Ray

The Ray tool creates a ray defined by an initial endpoint and extending infinitely in a specified
direction.

Note: You can constrain the slope to 15-degree increments by pressing the SHIFT key when
creating or modifying a ray.

Creating a ray

1. Select Ray from the Lines toolbox. |L| AeERENIEEED
2. Click to create or select the initial endpoint of the Create a point.
ray.
r{
3. Position the ray in the desired orientation, and click Click to specify the slope.

to specify direction and slope.

If the ray is created in free space, a point is not
created. If the ray is not in free space, it is attached
to a second point.

Modifying a ray

Translate a ray without changing its direction and slope
by selecting the Pointer tool from the Pointer toolbox.
Then using the Pointer :

» For aray constructed with a single point, drag
the point.

» For aray constructed with two basic points, grab
the ray away from the points and drag.

Change the direction and slope of a ray using the Pointer
tool:

» To change a ray constructed with a single point,
grab the ray away from the point and drag. Press
the SHIFT key to constrain the slope to 15-degree
increments.

» To change a ray constructed with two basic
points, drag either of the points.

» Changing a ray constructed with a dependent
point is relative to the object to which it is
attached. You may drag the object or the point,
depending on the construction.
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-~ Vector

The Vector tool creates a vector defined by magnitude and direction with a tail (initial endpoint)
and head (final endpoint).

Creating a vector

1. Select Vector from the Lines toolbox. N EEEREr e
2. Click to create or select the tail of the vector. Create the tail.

— %}‘
3. Move the pointer to the location for the head, and Create the head.

click to create or select the head of the vector.

Modifying a vector
Change a vector by dragging either endpoint.

Translate a vector constructed with two basic points by
grabbing the segment away from the endpoints, and
dragging it to a new location.
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Triangle

The Triangle tool creates a triangle defined by three points (vertices). A point placed on a triangle
can be moved along the entire perimeter of the triangle.

Creating a triangle

1. Select Triangle from the Lines toolbox.

MR ErEEEO)

2. Click to create or select the initial vertex. Creale the first veriex.
B
3. Move the cursor from the initial vertex, and then Create the second vertex.
click to create the second vertex. Repeat to create or e
select the final vertex. @

Create the final vertex.

Modifying a triangle
Move a triangle as an object by dragging one of its sides.
Change a triangle by dragging any of its vertices.

Note: Vertices dependent on other objects may restrict
movement or modification of the triangle.
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=] Polygon

The Polygon tool constructs an n-sided polygon of any shape defined by n points (vertices). A point
placed on a polygon can be moved along the entire perimeter of the polygon.

Creating a polygon
1. Select Polygon from the Lines toolbox. |L| CEE e ] Al I
2. Click to create or select the initial vertex. Create the initial vertex.

B

3. Move the cursor from the initial vertex, and then Create additional vertices.

click to create or select the other vertices. To
terminate polygon construction, double click or
select the initial vertex.

Modifying a polygon
Move a polygon as an object by dragging one of its sides. Select the original point.
Change a polygon by dragging any of its vertices. /yy This point
Polygon is complete.
%This polygon \
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.*;/| Regular Polygon

The Regular Polygon tool constructs a regular convex or star polygon defined by a center point and n
sides (30 or less). A regular polygon consists of congruent sides and congruent angles. A point
placed on a regular polygon can be moved along the entire perimeter of the polygon.

Creating a regular polygon
1. Select Regular Polygon from the Lines toolbox. w Eled AMdxd 1z s

2. Click to create or select the center point. Create the center point.

5

3. Move the cursor from the center point, and click to Specify the size.
specify the radius of a regular polygon.
\ (19}

The number of sides is displayed at the center point.

4. To create a regular convex polygon, move the cursor Rotate clockwise.
clockwise from its current position.
B
To create a regular star polygon, move the cursor
counterclockwise, and click when the regular polygon -
is the desired size.

Note: If you move beyond 30 sides or 180 degrees

from the initial vertex and the center point, a convex

polygon becomes a star polygon. A fraction is Pentagon.
displayed at the center point. The numerator

determines the number of sides; the denominator, the

number of times the star has crossed. The maximum

star is 30/13; the minimum is 5/2.
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Regular Polygon (Continued)

Modifying a regular polygon

Move a regular polygon as an object by dragging one of its
sides.

Change a polygon by dragging any of its vertices.

Dragging the center point changes the size of the regular
polygon since the original vertex is anchored (location

dependent).
FExample
1. Create the center point. 2. Specify the size.
® \ (18}
3. Rotate counter-clockwise. 4. 7/3 star polygon.
-
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Chapter 6: Using the Curves Toolbox

The Curves toolbox contains the tools associated with curve features in Cabri Geometry II. These
features allow you to create curved objects, including ellipses, parabolas, and hyperbolas.

The illustration below shows the location of the Curves toolbox on the Cabri Geometry II toolbar,
along with its pull-down menu. Procedures for using tools in the Curves toolbox, including
examples, are presented in this chapter in the order in which the tools appear on the pull-down
menu.

Curves toolbox

3 I S [0 U e < S P

v

Circle | = }I
" e
Arc '|
4
i
Conic " vl'
jl -
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Circle

The Circle tool creates a circle defined by a center point and a radius that can be specified in free
space, at an existing point, or on an object.

Note: You can constrain the radius to integer values by pressing the SHIFT key while defining or
modifying the radius.

Creating a circle

1. Select Circle from the Curves toolbox. |_p,| A Hedxd 1z A l
2. Create or select the center point of the circle. Create the center poin.
3. Move the cursor from the center point, and click once Specify the radius.

to set the radius.

If you click in free space, a point is not created. You
can also create or select a point.

Modifying a circle

To translate a circle without changing its radius, the circle
must be constructed with a single point. Drag the point to
translate the circle.

To change the radius of a circle:

» If the circle was created with a single point, grab
the circle anywhere on its circumference and drag.

» If the circle was created with a basic point, grab
either point on the circle and drag,.
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Arc

i

The Arc tool creates an arc defined by three points—two endpoints and a radius (or curvature)
point.

Note: By definition, an arc created on a circle has a radius equivalent to that of the circle.

Creating an arc

1. Select Arc from the Curves toolbox. DEE s EEEEREE

2. Create or select the initial endpoint of the arc. Create the initial point.
"k

3. Move the cursor from the initial endpoint, and click to Create the second point.

create or select the curvature point.

4. Move the cursor from the curvature point, and click to Create the final point.
create or select the final endpoint.

Modifying an arc
Change an arc by dragging any of its three points.

If an arc is defined by basic points, grab the arc away from
the points, and drag it to a new location.

Example
Construct a circle. Construct an arc on the circle.
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. :
3 Conic

The Conic tool creates a parabola, hyperbola, or ellipse defined by five points. Each point can
assume a new definition, depending on its location on the conic.

Creating a conic

1. Select Conic from the Curves toolbox. NOEE sl ErmE e

2. Click to create or select the five points. Create three points.

Note: After placement of three points, the conic is
drawn to aid you in placing the remaining points.

$

Shape with the fourth point.

.

Complete with the fifth point.

This ellipse

Modifying a conic

) ) . . o . Drag any point to reshape.
Move a conic by grabbing it away from its defining points,

and dragging it to a new location. If any of the points are
dependent, the conic also changes.
. . . . . . This hyperbola
Modify the conic by dragging any of its five points.
Note: Depending on the placement of the points, the
conic will be an ellipse, a hyperbola, or a parabola.
Examples

Conics in the coordinate plane:

- -

‘Qh This ellipse

This parf

-

+ - -
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Chapter 7: Using the Construct Toolbox

The Construct toolbox contains the tools associated with construction features in Cabri Geometry
II. These features allow you to construct objects in relation to other objects.

The illustration below shows the location of the Construct toolbox on the Cabri Geometry II
toolbar, along with its pull-down menu. Procedures for using Construct tools, including examples,
are presented in this chapter in the order in which the tools appear on the pull-down menu.

Construct toolbox

| AO [xe] e] alE

v

Perpendicular Line

Parallel Line

Midpoint

Perpendicular Bisector

Angle Bisector

M e

Vector Sum
Compass 'R
o
Measurement Transfer E.E'-'
—
i
Locus .
L]
. . L] .
Redefine Point o
il
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| Perpendicular Line

The Perpendicular Line tool creates a line passing through a point and perpendicular to a selected
linear object (line, segment, ray, vector, or side of a polygon).

Creating a perpendicular line

1. Select Perpendicular Line from the Construct toolbox. |L| A s 12 -“'i“ll

2. Point to the line, segment, ray, vector, or side of a Select a linear object.
polygon that will be perpendicular to the
constructed line, and click to select.

Perpendicular to this side of the triangle

3. Click to create or select the point through which Select a poind.
the perpendicular line will pass. %\By this point

Note: The order of steps 2 and 3 may be reversed.

A dependent line is created.

Modifying a perpendicular line

Move a perpendicular line by dragging the point through
which it passes.

The line cannot be altered directly because it is, by
definition, a dependent object.

Example

Select a linear object. Create a point, and the
perpendicular line is constructed.

ﬂ}j Perpendicular to this direction
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Parallel Line

1\

The Parallel Line tool creates a line that passes through a point and is parallel to a selected linear

object (line, segment, ray, vector, or side of a polygon).
Creating a parallel line

1. Select Parallel Line from the Construct toolbox.

2. Point to the line, segment, ray, vector, or side of a
polygon that will be parallel to the constructed line
and click to select.

3. Designate the point through which the parallel line
will pass.

Note: The order of steps 2 and 3 may be reversed.

Modifying a parallel line

Move a parallel line by dragging the point through
which it passes.

The line cannot be altered directly because it is, by
definition, a dependent object.

Example

(]

J A =5 1= Al=i]

Create a point, and the
Select a linear object. parallel line is constructed.

Parallel to this side of the polygon

Select a linear object.

Parallel to this side of the triangle

Select a point.

By this point

A dependent line is created.
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- *| Midpoint

The Midpoint tool creates a point at the midpoint of a segment or vector, the side of a polygon, or
between two points.

Creating a midpoint
1. Select Midpoint from the Construct toolbox. NI EEIEETIREE

2. Point to one of the following and click to select:

Two points (create or select). A segment. The side of a polygon.
L]
Modifying a midpoint
Modify a midpoint by modifying its defining objects.
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.'-'i,-f Perpendicular Bisector

The Perpendicular Bisector tool creates a line that is perpendicular to a segment, a vector, a side of a
polygon, or between two points, and passes through the midpoint of the selected object.

Creating a perpendicular bisector

1. Select Perpendicular Bisector from the Construct

NREEEIEEREERD|
toolbox.

2. Point to one of the following and click to select:

A segment or a vector. The side of a polygon. Two points (create or select).

Modifying a perpendicular bisector

A perpendicular bisector cannot be translated directly
unless it is constructed between two basic points.
Modifying the defining object causes the perpendicular
bisector to change accordingly.
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| Angle Bisector

The Angle Bisector tool creates a line that bisects an angle identified by three points. The second
point defines the vertex of the angle through which the line passes.

Creating an angle bisector

1. Select Angle Bisector from the Construct toolbox.

YT [ e e

2. Click to create or select three points that define the

angle to be bisected. (The second point selected is "
the vertex of the angle.)

Select points A, B, and C.

[
Select points, B, C, and A.

A

Modifying an angle bisector

An angle bisector cannot be translated directly unless it
is defined by three independent points. Modifying the

points that define the angle causes the angle bisector to
change accordingly.
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(R

Vector Sum

The Vector Sum tool creates a resultant vector that is the sum of two selected vectors. The selected

vectors do not have to share a common endpoint (tail) and may also be previously defined vector
sums.

Creating a vector sum

1. Select Vector Sum from the Construct toolbox.

NBEEIREE R

2. Point and click to select any two vectors. Select the first vector.

Q{I..] This vector

Select the second vector.

This vector

3. Click to create or select the initial point for the Select a tail point for the vector sum.
resultant vector.

Modifying a vector sum

A vector sum cannot be modified directly. Modifying
either one of the selected vectors causes the vector sum
to change accordingly.
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Compass

The Compass tool creates a circle with a radius equal to the length of an existing segment or the
distance between two points.

Creating a circle using Compass

1. Select Compass from the Construct toolbox.

[a] 1Al Tdnd 1424 2]

2. Create or select two points or select a segment to Select a segment.

define the radius of the circle. —
'Q% This segment

3. Create or select the center point of the circle. Select a center point.

Modifying a circle created using Compass

Modify the radius by dragging one of the defining
endpoints.

Translate the compass circle by dragging the center
point.
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| Measurement Transfer

The Measurement Transfer tool creates a point on a ray, on a vector, from the initial point of a
polygon, or from another point at a distance proportional to a selected measurement or numerical
value. From a point on a circle, the point created is at an equivalent arc length. The direction of the
distance or arc length depends on the sign of the selected numerical value.

The magnitude of the measurement transferred is represented without regard to units.

Creating a measurement transfer

1. Select Measurement Transfer from the Construct
toolbox.

2. Point to any measurement or numerical value and
click to select.

3. To construct:

» apoint at a proportional linear distance, select a
ray, vector, polygon, or point. If you select a
point, a dotted line appears. Position the dotted
line as you want it, and click to set the position.

DEEEIZEREEE |

Select a numerical value.

Z10em

This number

Select a ray.

‘ﬁﬂ"l This ray

The point created is an equivalent
distance from the endpoint of the ray.

10 em

» apoint at a proportional arc length away, select

a circle, and then select (do not create) a point

on the circle.

The point created is an

Select a Select Select an existing equivalent arc length from the

numerical value. a circle. point on the circle. existing point.
e @i u 4
‘3!1"] This number ' This circle
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Measurement Transfer (Continued)

Example
Select a Position the point and click. The
numerical value. Select a point. points are 2.5 cm apart.
25 BE 25
“\“"J This number T
. [ .. L ] [ ]
%3 T

Modifying a measurement transfer

Modify the constructed point by changing the
measurement or numerical value. The point cannot be
translated directly.
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ha A1 Locus

The Locus tool creates a set of objects defined by the movement of a point along a path. When you
select a point on a path (object), the locus is completely constructed and is considered a defined
object. As such, points can be attached. When you modify an object that defines a locus, the locus
is recalculated and continuously displayed to show the effects of the modifications.

With defaults set, a locus is constructed with 30 (Macintosh) or 50 (Windows, DOS) objects equally
spaced along the designated path. You can change this setting using Preferences in the Options menu.
Choices for connecting locus points and constructing the envelope of a line are also available under
Preferences . See “Options Menu” in the chapter “Using the Menus” for more information. As an
alternate method for changing the number of objects that define the locus, you can select the locus
and then press + or - to increase or decrease the number of objects that define the displayed locus.

Creating a locus

1. Select Locus from the Construct toolbox. NEEEIrERIEERED

2. Select the object for the locus. Preconstructed objects.

Select the object.

&

3. Select a point that lies on a path. Select a point on a path.

Note: A path is any defined object on which a point
can be placed.

As its center travels around the first circle, the locus of a
second circle through a point on a circle is constructed.

D}

ff'n i
{THES
i

'ii ‘ii‘w :
iR
W
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Locus (Continued)

Modifying a locus
Modify a locus by changing its defining objects.

Example
Take the locus of the segment as one
Construct an Attach a segment to a of its endpoints travels around the
ellipse (conic). new point on the ellipse. ellipse.
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"+ =] Redefine Point (Macintosh and DOS only)

The Redefine Point tool modifies the current definition of any point, as long as the new definition
does not create a circular reference.

A circular reference occurs when a point that defines an object is redefined to be on that object.
An example is defining the center point of a circle to be a point on the circle. This is not allowed.

Redefining a point
1. Select Redefine Point from the Construct toolbox. NI EE] ["j| %] 1z e
2. Press and hold the mouse down on any point. Attach an existing segment to a circle.

A dialogue box appears with the following options:

» Point —redefines the point as a basic point at the
same location.

» Pointon Object — redefines the point to be on an

object. Select the endpoint.

Padsd

» Intersection Point(s) — redefines the point to be at Prwe et
the intersection of two objects. I

Teampinr b ame Far pard !
» Transfer to another point — transfers the point to \
another existing point.

Click to create a point on a circle.

3. Select the desired option. If you selected Point, step 4
is not necessary.

4. Click to select an object compatible with the
selected option and to assign its new definition.

The segment is attached to the circle.
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"+ ~| Redefine Object (Windows only)

The Redefine Object tool modifies the current definition of any object. You can redefine a circle, arc,
conigc, triangle, segment, ray, vector, polygon, or regular polygon.

Redefining an object

1. Select Redefine Object from the Construct toolbox.

2a. If the object is a point, hold the mouse on the point,
and then select the new definition.

4
4

Point — redefines the point as a basic point.

Point on Object — redefines the point to be on an
object.

Intersection Point(s) — redefines the point to be at
the intersection of two objects.

Transfer to another object — transfers and merges the
point to another existing point.

2b. If the object is an object, hold the mouse on the
object, and then select the new definition.

4

Circle, Triangle, Segment, etc. — lets you construct a
new object of the same type and automatically
transfer the original object to it.

Transfer to another object — transfers and merges the
object to another existing object of the same

type.

2c. If the object is a line, hold the mouse on the line, and
then select the new definition.

4

Line — lets you construct a new line and
automatically transfer the original line to it.

Perpendicular — redefines the line to be
perpendicular to another object.

Parallel Line — redefines the line to be parallel to
another object.

Perpendicular Bisector — redefines the line to be the
perpendicular bisector of another object.

Angle Bisector — redefines the line to bisect an
angle determined by three points.

Transfer to another object — transfers and merges the
line to another existing line.

3. Click to select an object compatible with the
selected option and to assign its new definition.

[a] -1 Acl THdnd 142 afef]

A pop-up menu appears with
the following options:

Faoint

Point on Object
Intersection Points
Transferto anather object

A pop-up menu appears with
the following options:

Circle
Transter to another ohject

A pop-up menu appears with
the following options:

Line

Ferpendicular Line
Parallel Line
Perpendicular Bisector
Angle Bisector
Transfer to another object
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Chapter 8: Using the Transform Toolbox

The Transform toolbox contains the tools associated with Cabri Geometry II transformation
features. These features allow you to translate, reflect, rotate, and dilate objects according to

specified factors and angular values.

The illustration below shows the location of the Transform toolbox on the Cabri Geometry II
toolbar, along with its pull-down menu. Procedures for using Transform tools, including examples,
are presented in this chapter in the order in which the tools appear on the pull-down menu.

Transform toolbox

NI EE I TS

Reflection . l\ll m
Symmetry .
Translation —:“"' -
Rotation )
Dilation

-
=l '-‘..
Inverse
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|E 'l Reflection

The Reflection tool creates the mirror image of an object reflected across a line, segment, ray,
vector, axis, or side of a polygon.

Creating a reflection

1. Select Reflection from the Transform toolbox. |L| IEEE e _4|iur||
2. Select the object to reflect. Select the object to reflect.

H Reflect this polygon

3. Select the line, segment, ray, vector, axis, or side of a Select the linear object.

polygon to reflect the object across. i'ﬂ., with respect o this e

The reflected object is created.

Modifying a reflection

Change the reflected image by changing the original
object or by modifying the line of reflection. Because it is
a dependent object, you cannot change the reflected
image directly.
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.= "] Symmetry

The Symmetry tool reflects the image of an object 180-degree with respect to a point.

Creating a symmetrical image

1. Select Symmetry from the Transform toolbox. |L| IEEE Rt _-1IIH'||
2. Select the object to reflect 180 degrees. Select the object to reflect

Reflect this pdlygon

3. Select the point of symmetry. Select a point.
= with respect to this object

The symmelric image is created.

Modifying a symmetrical image

Change a symmetrical image by changing the original
object or by moving the point of symmetry. Because it
is a dependent object, you cannot change a symmetrical
image directly.

Copying permitted provided T copyright notice is included Chapter 8: Using the Transform Toolbox 8-3
© 1997, 1999 Texas Instruments Incorporated



—= .| Translation

The Translation tool creates the image of an object translated by a specified, previously defined
vector.

Translating an object

1. Select Translation from the Transform toolbox. |L| IEEE R IEEE N

2. Select the object to translate. Select the object to translate.

!'| Translate this polygon

Select the translation vector.

3. Select the vector that defines the translation
direction and distance.

The translated image is created.

—_—

Modifying a translation

Move a translated image by dragging the vector head or
tail to a new location. The translated image changes
according to the changes of the vector or changes to the
original object. Because it is a dependent object, you
cannot change the translated image directly.
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A

Rotation

The Rotation tool rotates an object by a specified angular value with respect to a point.

Note: The angular value may be any measurement or numerical value, regardless of units. The
units are presumed to be degrees by the software. A positive angular value rotation is performed in
a counter-clockwise direction.

To create specific angles of rotation, please refer to “Numerical Edit” in the chapter “Using the
Display Toolbox.”

Rotating an object

1. Select Rotation from the Transform toolbox. |ﬂ IEEE et IEEEE ||
2. Select the object to rotate. Select the object to rotate.
457

(‘:!.IM Rotafe this polygon

3. Select the point of rotation. Select the rotation point.
45°
frmmmmmmm- 7
et
-
. H— :
q\‘l‘h‘] around this point
4. Select the angular value of rotation. Select the angular value of rotation.
45 using this angle
frommmmmmms 7
e
-
. R :

The rotated image is created.

Modifying a rotation 45°

Change the rotated image by either modifying the figure

that defines the angle of rotation, editing the value

created by Numerical Edit , moving the rotation point, or

changing the original object. Because it is a dependent -
object, you cannot change the rotated image directly.
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£_»#] Dilation

The Dilation tool dilates an object by a specified factor with respect to a specified point.

Note: This factor may be any measurement or numerical value, regardless of units. The value is
presumed to be unit-less.

To create specific factors of dilation, please refer to “Numerical Edit” in the chapter “Using the
Display Toolbox.”

Dilating an object

1. Select Dilation from the Transform toolbox. |ﬂ | Ae MER = A |

2. Select the object to dilate. Select the object to dilate.
05

Dilate this polygon

3. Select the point of dilation. Select the dilation point.
05 R B}

P—

O

4. Select the factor of dilation. Select the dilation factor.
&5 using this factor
pemecd
i ----- -

The dilated image is created.
N =]

=

Modifying a dilation

Change the dilated image by either modifying the figure
that defines the factor, editing the value created by
Numerical Edit , moving the dilation point, or changing the
original object. Because it is a dependent object, you
cannot change the dilated image directly.
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(C4"] Inverse

The Inverse tool constructs an inverse point with respect to a circle and a point, according to the
equation OM « O M' =2

where:

M and M' are points that lie on a ray with endpoint O.

(@] = center of circle.

M = selected point.

M = inverse point.

* = radius of selected circle.

As the selected point approaches the center point, the inverse point approaches a point at infinity.
If M is defined to be on a line passing through the circle, the locus of M' constructs a circle that
passes through the center of the circle.

If the original point lies in the interior of the circle, the inverse point is constructed in the exterior,
and vice versa. The inverse point lies on a ray with the center point as the endpoint.

Creating an inverse point

1. Select Inverse from the Transform toolbox. |ﬂ BRI ErEE A1l

2. Create or select a point as the original point. Select a point.

'
H . H This point
1 4

3. Select a circle. Select a circle.

This circle

An tnverse point is created.

Modifying an inverse point

Move an inverse point by dragging the point or modifying
the circle that defines it. You cannot manipulate an
inverse point directly because it is a dependent point.
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Chapter 9: Using the Macro Toolbox

The Macro toolbox contains the tools associated with constructing macros in Cabri Geometry II. A
macro is a sequence of interdependent constructions. Macros are useful for creating new tools that
construct unique objects or perform repetitive tasks.

The illustration below shows the location of the Macro toolbox on the Cabri Geometry II toolbar,
along with its pull-down menu. Procedures for creating macros, including rules and examples, are
presented in this chapter in the order in which macros must be created.

Macro toolbox

S R O R | P S L

v
Initial Object }{_,..

Final Object *Y

Define Macro :I[ _"T
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How to create a macro

A macro constructs “final” objects based on “initial” objects. Intermediate objects are not
constructed. This feature allows easy construction of complex figures and is the primary method
for constructing fractals. You can save macros on disk for later use. Macros are automatically
saved with any file in which they are used.

To create a macro:

1.
2.

3.

Select the initial objects required to define the final object(s).

Select the final object(s), and then, if necessary, change the attributes of the object(s) as they
will appear in the final construction.

Define the macro for inclusion in the Macro toolbox. The macro is then available for use.

Read the following rules, and then refer to the step-by-step procedures that follow them.

Rules for creating macros

4

Initial objects must allow the construction of all final objects. Final objects must be
determined by the initial objects. A macro must respect the logical structure of the figure as it
was constructed.

An object cannot exist without the points that define it. For example, a triangle cannot exist
without its vertices. Therefore, when you select an object as an initial object, the macro is able
to refer to the points that define the object.

When you select Define Macro , a macro generates its final objects with the object’s existing
attributes. You can change these attributes during an intermediate step before you select Define
Macro. In this way, you can hide objects (using Hide/Show in the Display toolbox) that were
selected as initial objects.

Because macros are intended as general purpose construction tools, like those in the Construct
toolbox, comments and labels cannot be defined as final objects. You can select
measurements and numerical values as final objects, but any text attached will not be
duplicated when the macro executes.

The location of an arbitrary point on an object is determined by a random-number generation.
Therefore, the position of the point will be uncertain if it is selected as a final object.

If the initial objects are different types (for example, lines and circles are different types), they
are not used in any order. If the initial objects are the same type, the macro uses them in the
order in which they were selected as initial objects.

The number of objects created by a macro is limited only by available system memory.

Macros are automatically saved with any construction in which they are used. You can also
save macros in a tool configuration file (see Options Menu in the chapter "Using the Menus").

The first final object you select is considered the primary object of the macro. If a name is
entered in the Name for first final object  field, it will be the cursor message when the cursor is in
the vicinity of the primary object. For the Macintosh, the Name for first final object  field is found
under the More option in the Macro dialog box. For the Windows and DOS versions, the Name for
first final object field is already visible in the dialog box.

To save multiple definitions for a single macro, select the initial and final objects for the new
definition, and save it with the same name. The dialog box generated in Define Macro allows you
to select previous macros when saving a macro. For example, you may want to define a macro
that constructs a triangle with vertices at the midpoints of an initial triangle, a polygon with
vertices at the midpoints of a three-sided polygon, and a triangle with vertices at the midpoints
of a three-sided regular polygon. A single macro can perform all of these operations if each
case is identified with appropriate initial and final objects and saved to the same macro file.
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Initial Object

The Initial Object tool specifies the initial object(s) needed to define the given conditions for a
macro. See “Rules for creating macros” for more information.

Specifying initial object(s)

1. Select Initial Object from the Macro toolbox. NEEEFEE cEE ]

2. Click once to select an object. Select initial objects.

M triangle

=]

The selected object displays in marquee outline.

Selected objects.

3. (Optional) Click again on the object to deselect it.

The object returns to its original outline.
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Final Object

The Final Object tool specifies the final object(s) that will result from the initial objects defined for a
macro. See “Rules for creating macros” for more information.

Specifying final object(s)

1. Select Final Object from the Macro toolbox.

DREEPECEEERH|

2. Click once to select an object. Select final objects.

This circle

Select objects.
The selected object displays in marquee outline.

3. (Optional) Click again on the object to deselect it.

The object returns to its original outline.
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Define Macro

The Define Macro tool stores a macro in memory. A dialog box appears for you to name the macro.
This dialog box is described below. Also see “Rules for creating macros” at the beginning of this
chapter.

The Define Macro dialog box

The Define Macro dialog box appears (Macintosh version illustrated) when you select Define Macro
after defining valid initial and final objects. Each field is defined below.

Note: The Define Macro dialog box for the Windows and DOS versions is slightly different from the
Macintosh version. The first screen is displayed only in the Macintosh version. In the next screen,
the Icon font option is different in the Windows and DOS versions.

Macintosh only Macintosh, Windows, DOS

Hams al (he cermireL e waww ol 1be consbiun lims !
_.l CERa bR HiEn _;-I Iean foni: [R] = | -I.lll.:l.l.r.h... ] EETRTTOIOT TR ~ | cor imi: .._.Il" =
— TR E [ N T ke T Lew o el E [liaee in fis
mgewp Mpr el final ll_rl ]
.l'Fl 1T AN T
IgRF i SmEe | Fal
Name of the Enter a name for your construction or select a previously named macro.

construction To access a previously named macro, point to the arrow on the right-hand
side of this field and press and hold the mouse button. The name entered
here will appear in the Macro toolbox when you select OK or OK and save.

Icon font; The first letter of the construction name entered above appears in this

(Macintosh only) field. This letter will be used for the icon of the macro in the toolbar. You
may select the font of this letter from Roman, Old English, or Fraktur.

Cancel Click on this button to cancel or disregard the macro definition. Initial and
final objects will be deselected.

More/Less: This button is a toggle. Click on it to show More or Less options.

(Macintosh only)

Name for first final
object

Help for this macro

Enter the name that you want to appear as a cursor message when the
cursor is in the vicinity of the first object created by the macro.

Enter the message that you want to appear in the help window when the
macro is selected.

Copying permitted provided Tl copyright notice is included
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Define Macro (Continued)

Save to file

OK/OK and save

Specifying a macro

1. Select Define Macro from the Macro toolbox.

2. Enter the requested information into the dialog box to

save your macro.

If you receive a warning message instead of the dialog
box, a problem exists in the definition of initial and
final objects. Review “Rules for creating macros” at
the beginning of this chapter, and redefine your initial

and final objects.

This button is a toggle. Click on it to change the OK to OK and save , and vice

versa.

Click on OK to save the macro for use in your construction. The macro is
not saved to a separate file but is saved with your construction. Once
saved, the macro can be used in future Cabri Geometry II sessions.

Click on OK and save to generate a save file dialog that allows you to save
the macro to a file you specify. Macros saved to individual files can be
recalled in future constructions by using Open in the File menu to open the

macro file.

OEEEEEzIEEEDT

Define Macro dialog box.

i ol B et
LR TIE P v | v i | B ] i v o

] () D

Select a new macro.

Select an appropriate object.

This triangle

Click to apply the macro.
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Chapter 10: Using the Check Property Toolbox

The Check Property toolbox contains the tools associated with Cabri Geometry II property features.
These features allow you to check the validity of geometric properties in general. Results are
reported in text, which can be edited with the Comments tool located in the Display toolbox.

The illustration below shows the location of the Check Property toolbox on the Cabri Geometry II
toolbar, along with its pull-down menu. Procedures for using Check Property tools, including
examples, are presented in this chapter in the order in which the tools appear on the pull-down

menu.
Check Property toolbox
| | AD M =] Az
v

Collinear R

Parallel __-a-"
—
J:l

Perpendicular '

Equidistant ? ?{
L ——

Member __E_i,
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Collinear

The Collinear tool evaluates three selected points to determine whether or not they lie on the same

line. The results are reported in text.
Checking collinearity
1. Select Collinear from the Check Property toolbox.

2. Select any three existing points.

A marquee box appears after the last selection.

3. Move the pointer to move this box anywhere in the
drawing window, and click to display the result.

If you change the points so that the property changes,
the displayed text changes accordingly.

MEEEFErIsEEED

Select three points.

By

Click to place the marquee box.

Points are not collinear

The result changes with the construction.

Points are collinear

10-2
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T

Parallel

The Parallel tool evaluates any combination of two selected lines, segments, rays, vectors, axes, or
sides of a polygon to determine whether or not they are parallel. The results are reported in text.

Check parallelism

1. Select Parallel from the Check Property toolbox. o |- Mo iz A=

2. Select any combination of two lines, segments, rays, Select two linear objects.
vectors, axes, or sides of a polygon.
A marquee box appears after the last selection. =~ S E@ __________________________
3. Move the pointer to move this box anywhere in the Click to place the marquee box.

drawing window, and click to display the result.

Objects are not parallel

/

If you change the objects so that the property The result changes with the construction.
changes, the displayed text changes accordingly.

Objects are parallel
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j.( Perpendicular

The Perpendicular tool evaluates any combination of two selected lines, segments, rays, vectors,
axes, or sides of a polygon to determine whether or not they are perpendicular. The results are
reported in text.

Checking perpendicularity
1. Select Perpendicular from the Check Property toolbox. Y| J _|'__j ___,_I = 3] r]ﬁl _4||u|

2. Select any combination of two lines, segments, rays, Select two linear objects.
vectors, axes, or sides of a polygon.

A marquee box appears after the last selection.

Click to place the marquee box.
3. Move the pointer to move this box anywhere in the
drawing window, and click to display the result.

Objects are not perpendicular

i Th It ch ith th truction.
If you change the objects so that the property changes, ¢ Tesult chmnges Wit the construction

the displayed text changes accordingly.

] Objects are perpendicular
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" #| Equidistant

The Equidistant tool evaluates any three points to determine whether or not the first point is
equidistant from the two remaining points. (If a point is equidistant from the endpoints of a
segment, then the point lies on the perpendicular bisector of the segment.) The results are

reported in text.

Checking equidistant property
1. Select Equidistant from the Check Property toolbox.

2. Select any three points. (The first point selected is
checked relative to the two remaining points.)

A marquee box appears after the last selection.

3. Move the pointer to move this box anywhere in the
drawing window, and click to display the result.

The text states whether or not the first point selected
is equidistant from the second and third points.

If you change the objects so that the property changes,
the displayed text changes accordingly.

D EE P m e

Select, in order, points A, B, and C.

]
-
8 C
Click to place marquee box.
A

E C

Points are not equidistant

The result changes with the construction.
A

B

Points are equidistant
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=1 Member

The Member tool evaluates a point to determine whether or not it lies on an object. The results are
reported in text.

Checking membership

1. Select Member from the Check Property toolbox. DEEEFECI=ERED

2. Select a point. Select a point and an object.

3. Select any object.

A marquee box appears after the selection.

B

4. Move the pointer to move this box anywhere in the Click to place the marquee box.
drawing window, and click to display the result.

If you change the objects so that the property changes,
the displayed text changes accordingly.

This point does not lie on the object

The result changes with the construction.

This point lies on the object
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Chapter 11: Using the Measure Toolbox

The Measure toolbox contains the tools associated with measurement features in Cabri Geometry
II. These features allow you to perform different measurements and calculations.

The illustration below shows the location of the Measure toolbox on the Cabri Geometry II toolbar,
along with its pull-down menu. Procedures for using Measure tools, including examples, are
presented in this chapter in the order in which the tools appear on the pull-down menu.

Measure toolbox

3 [ S o e < | R S

Distance & Length

Area

Slope

Angle

Equation & g:[i_:c]
Coordinates

Calculate .I

Tabulate
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| Distance & Length

The Distance & Length tool calculates and displays distance, length, perimeter, circumference, and
radius.

The default measurement is displayed in centimetres. You can change its precision by using
Numerical Edit in the Display toolbox. Numerical Edit also allows you to change the font, size, style,
colour, and units.

You can add a comment to the measurement immediately after creating it by typing the text. See
“Comments” in the chapter “Using the Display Toolbox” for more information on adding a comment
to a numerical value.

Measuring objects

1. Select Distance & Length from the Measure toolbox. |_|.,] IR EE I L |

2. To measure: Select an object.

» length, perimeter, or circumference — select an
object. a\ﬂ..’ Length of this segment

» distance — select two points.

» radius - select the center point and then the
circumference.

The result is displayed.

.07 em

Moving measurements

Reposition the measurement by selecting it with the Pointer
tool and dragging it to a new position.

The measurement moves with the object it measures
unless you pull it away. When you pull it away from the
object, the measurement momentarily resists before
pulling away.
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Area

The Area tool calculates and displays the area of a selected polygon, circle, or ellipse.

The default measurement is displayed in square centimetres. You can change its precision by using
Numerical Edit in the Display toolbox.

You can add a comment to the measurement immediately after creating it by typing the text. See

“Comments” in the chapter “Using the Display Toolbox” for more information on adding a comment
to a numerical value.

Checking area

1. Select Area from the Measure toolbox. DEEEFEREREEED

2. Select the polygon, circle, or ellipse whose area you Select the object.
want to measure.

This polygon

The result is displayed.

5267 omt

Moving measurements

Reposition the measurement by selecting it with the Pointer
tool and dragging it to a new position.

The measurement moves with the object it measures
unless you pull it away. When you pull it away from the
object, the measurement momentarily resists before
pulling away.
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21| Slope

The Slope tool calculates and displays the slope of a selected segment, ray, vector, or line.
You can change the precision of the slope by using Numerical Edit in the Display toolbox.

You can add a comment to the measurement immediately after creating it by typing the text. See

“Comments” in the chapter “Using the Display Toolbox” for more information on adding a comment
to a numerical value.

Checking slope

1. Select Slope from the Measure toolbox.

DEEEFEREEED

2. Select the segment, ray, vector, or line whose slope

Select the object.
you want to measure.

This line

The result is displayed.

= 1.000

Moving measurements

Reposition the measurement by selecting it with the Pointer
tool and dragging it to a new position.

The measurement moves with the object it measures
unless you pull it away. When you pull it away from the

object, the measurement momentarily resists before
pulling away.
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Angle

The Angle tool calculates and displays the measurement of an angle defined by an angle mark or
three selected points. The second point must be the vertex.

If you use Angle to select three points, angle measurements default to angles from 0 to 180 degrees
(interior angles). If you want measurements greater than 180 degrees (reflex angles), you must first
mark the angle with Mark Angle in the Display toolbox. The default measurement is displayed in
degrees. You can change its precision by using Numerical Edit in the Display toolbox.

You can add a comment to the measurement immediately after creating it by typing the text. See
“Comments” in the chapter “Using the Display Toolbox” for more information on adding a comment
to a numerical value.

Checking angles
1. Select Angle from the Measure toolbox. ) [ S s I s s e L

2. If an angle mark is displayed on the angle, select the Select three points.
angle mark to measure the angle. Otherwise, select
three points to specify the angle. The second point
must be the vertex.

This point

The result is displayed.

45.000 ¢

Moving measurements

Reposition the measurement by selecting it with the Pointer
tool and dragging it to a new position.

The measurement moves with the object it measures
unless you pull it away. When you pull it away from the
object, the measurement momentarily resists before
pulling away.
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J:Ii 1)

Equation & Coordinates

The Equation & Coordinates tool displays the equation of a line, circle, conic, or coordinates of a point
with respect to a default coordinate system.

You can change the precision by using Numerical Edit in the Display toolbox. You can change the form
of the equation by using the options under Preferences in the Options menu or by selecting the
equation and pressing TAB.

Checking equation or coordinates

1. Select Equation & Coordinates from the Measure toolbox. |_p,] IEEREERE R el

2. Select the point, line, circle, or conic whose equation
you want to find. If multiple coordinate systems are
present, you must select the coordinate system before
the equation is displayed.

Select an object. The result is displayed. Select a point to display its
coordinates.

Equation of this circle

(- 07330+ (y - 048 =2}
(% - 0723+ (y - 048K =22

(0.73%, 0.400)

Modifying the equation or coordinates

The equation is updated as you modify the object. The
values composing the equation are based on the
coordinate system.

Reposition the equation by selecting it with the Pointer tool
and dragging it to a new position.

The equation moves with the object it measures unless
you pull it away. When you pull it away from the object,
the equation momentarily resists before pulling away.
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Calculate

The Calculate tool opens a calculator at the bottom of the screen. You can perform calculations
using measurements, numerical values, calculation results, and numerical inputs from the
keyboard. When you change the components of a calculation, the result is updated.

The calculator shown below is displayed at the bottom of your computer screen. It cannot be
moved from this position. Once selected, the calculator remains ON (visible) until you press the
OFF button. The calculator becomes active as soon as you select the Calculate tool. It becomes
inactive when you perform any action not directly associated with a calculation. To reactivate the
calculator, you can either select the Calculate tool or click in the calculator edit window.

edit window

(@) (Cance)| =1
(inu) (STN) €05 fN 0D HOEE &)

result window

Calculations are entered in the edit window. See the procedure “Entering a calculation” in this
section for how to enter a calculation. A measurement or numerical value from the Cabri
Geometry II drawing window is represented in the edit window as a variable a, b, c, ..., 2. This
variable is also shown next to the value in the Cabri Geometry II drawing window. The value's full
precision will be used in the calculation. All parentheses must be closed when entering a
calculation.

You can extract the abscissa and ordinate from any coordinate set by clicking on each value
individually.

The calculation result is displayed in the result window. You can drag the result to the Cabri
Geometry II drawing window. When you drag the result to the drawing window, a tag identifying it
as a calculation result is dragged along with it. See the step for copying the result to the drawing
window in the procedure “Entering a calculation” on page 11-10.

You cannot modify values in the result window. However, on the Macintosh and Windows
versions, you can edit results using Numerical Edit once they are in the drawing window. In addition
to using the standard Numerical Edit features, you can display and change the composition of the
result by selecting the Calc option in the Numerical Edit window. For the DOS version, select the
Calculate tool, and double-click on the result to get the original formula back in the edit window. If
you change the composition of a calculation, its result is automatically updated in the drawing
window. (See “Numerical Edit” in the chapter "Using the Display Toolbox" for more details.)

If two different but compatible units are involved in a calculation, the result is displayed with the
default units specified in Preferences under the Options menu (for example, 2 cm + 4 mm = 2.4 cm).

The calculator gives three types of warnings:
»  division by zero

»  parentheses not closed

» incompatible units

Both division by zero and parentheses not closed must be corrected before the calculation can be
performed. For incompatible units , Cabri Geometry II offers the option to disregard the units and to
perform the calculation as if the values were without units.
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Calculate (Continued)

Function buttons on the calculator contain mathematical functions. Click on a function button to
display its operation in the edit window. The following table describes the functions available from
the calculator function buttons.

Function Button Operation Syntax
Off Turns off calculator. Calculator disappears. none
Cancel Clears last entry. none
Inv Generates the inverse of the following none
functions:
Inv-SIN Calculates the arcsine. arcsin(value)
Inv-COS Calculates the arccosine. arccos(value)
Inv-TAN Calculates the arctangent. arctan(value)
Inv-~/ Calculates square of a number (x?). sqr(value)
Inv-LN Calculates the natural antilogarithm (e%). exp(value)
Inv-LOG Calculates the common antilogarithm (10%). 10* (walue)
SIN Calculates the sine. sin(value)
CosS Calculates the cosine. cos(value)
TAN Calculates the tangent. tan(value)
N Calculates the square root (V). sqrt(value)
A Raises a number to a power (y%). valuel "value2
LN Calculates the natural logarithm (base e). Ln(value)
(The value used for e is 2.718281828.)
LOG Calculates the common logarithm. Log(value)
ABS Calculates the absolute value. Abs(value)
m Includes the value of & (pi) — 3.141592654. (On 1t
the Macintosh, OPTION+p may also be used for
)
() Adds parentheses. The keys () may also be (value)
used.
+ -0+ Adds mathematical operators addition, +, - 0=+

subtraction, multiplication, and division. The
keyboard may also be used: + for addition, —
for subtraction, (for multiplication, and / for
division (+).

Performs the calculation. Pressing the return
key also performs the calculation.

11-8
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You can also enter mathematical functions from the keyboard. The following table lists the syntax
for the mathematical functions supported by the calculator.

Function Syntax
Absolute Value ABS(value), abs(value), Abs(value)
Square SQR(value), sqr(value), Sqr(value), Sq(value)

Square Root

Logarithm base 10
Natural Logarithm
Exponential ex

Lowest Integer, Floor
Greatest Integer, Ceiling
Round (to nearest integer)
Sine

Cosine

Tangent

Arc Sine

Arc Cosine

Arc Tangent

Hyperbolic Sin
Hyperbolic Cos
Hyperbolic Tan

Arc Hyperbolic Sine
Arc Hyperbolic Cosine
Arc Hyperbolic Tangent
Minimum of (n1, n2)
Maximum of (nl, n2)
Pi (9

Exponent

SQRT(value), sqrt(value), Sqrt(value), SqRt(value), V(value)
logl0(value), Logl0(value), Ig(value)

LN(value), In(value), Ln(value)

EXP(value), exp(value), Exp(value)

FLOOR(value), floor(value), Floor(value)

CEIL(value), ceil(value), Ceil(value)

ROUND(value), round(value), Round(value)

SIN(value), sin(value), Sin(value)

COS(value), cos(value), Cos(value)

TAN(value), tan(value), Tan(value)

ARCSIN(value), arcsin(value), asin(value), ArcSin(value)
ARCCOS(value), arccos(value), acos(value), ArcCos(value)
ARCTAN(value), arctan(value), atan(value), ArcTan(value)
SINH(value), sinh(value), SinH(value), sh(value)
COSH(value), cosh(value), CosH(value), ch(value)
TANH(value), tanh(value), TanH(value), th(value)
ARCSH(value), arcsh(value), ArcSh(value)

ARCCH(value), arcch(value), ArcCh(value)

ARCTH(value), arcth(value), ArcTh(value)

MIN(valuel, value2), min(valuel, value2), Min(valuel, value2)

MAX(valuel, value?), max(valuel, value2), Max(valuel, value2)

1, M, PL, pi, Pi
10~ (value)
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Calculate (Continued)

Entering a calculation

1.

Select Calculate from the Measure toolbox.

Enter an expression in the edit window using any
combination of the following methods:

» Click on any of the function buttons.

» Point to any numerical value in the drawing
window, and click to copy it.

» Type in a function or a number.

Click the = button (or press ENTER) to perform
the calculation and display the result in the result
window.

Click in the result window to copy the result to
the drawing window. Click again in the drawing
window to place the result.

Editing a calculation

1.

Select the result with the Numerical Edit tool. (On
the Macintosh, click on the Calc button. You must
point to the number.) You can also select the
Calculate tool and double-click the result
composition to the edit window.

The composition of the result is displayed in the
calculator edit window.

Note: The display attributes options in the
Windows version are determined in the
Options/Preferences/Default Styles dialog box.
These options are not available in the DOS
version.

Edit the composition as described above in
“Entering a calculation.”

Cancel][05 * a * d

(Inu] [SIN] [COS] [TAN]

Select the = button to display the result.

JSH?. 104 em2 | ||

Click to place the result.

Result: 7.104 cm?
Height: .07

E ) Base: 4 &3 & o
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ﬁ Tabulate

The Tabulate tool collects selected measurements, calculations, and numerical values into a single
data table. You must define the table before values can be entered.

When you select values for tabulation, they are entered into the next available column of the table.
If the value has a label comment, it is copied into the first row of the column and the value is
copied into the next available row. If the value does not have a label comment, the first row will be
empty for that column. Comments that you later add to tabulation values are copied into the first
row in that value’s column. See “Comments” in the chapter “Using the Display Toolbox” for
instructions on adding a comment to a numerical value.

The values in a column are not displayed unless the full width of the column is visible. Each row of
the table is numbered sequentially in the first column on the left. You can enter single values into
the table when at least one object changes and you press the TAB key.

You can collect data automatically by selecting the table, and then using Animation . Data is stored in
the table for each of the defined tabulation values at a rate relative to the animation.

You can delete columns or rows, and change column width (see page 11-13). The maximum
number of rows is 999. The number of columns is limited by memory.

You can make only one table for each Cabri Geometry II drawing. You can copy the values in a
table to another program (such as a spreadsheet program). First, select the table with the Pointer
tool, and use Copy from the Edit menu. Then go to the target program, and paste the data.

Note: The example tables shown on the following pages are for the Macintosh version using the
Chicago font. The display attributes options are not available for the Windows and DOS versions;
therefore, the fonts displayed on your screen will be different.
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Tabulate (Continued)

Using Tabulate
1. Select Tabulate from the Measure menu. |L| 14 = - <=1
2. Define the table by dragging the marquee rectangle to Drag rectangle to size the table.

size the table. You can resize the table by dragging the
lower right corner.

. . . o Click on each value to be tabulated.
3. Point to a numerical value, and click to enter it into

the table. Area 1.2601 cm:
Radius 0.63 cm

G

2
{l»J This number

Radius Area
1 0.63 1.2601
2
3
4
o
4. Press TAB to record new values Press the TAB key to tabulate entries.
Note: At least one value must change before a new r "adi':]s =3 “":“2 01
row is entered. 5 VBT ATE
To tabulate values automatically, first select the table, : ;:33 l;:gggg
and then animate the construction using Animation or 5 500585995
Multiple Animation  (in the Display toolbox).
When selected, the table displays with a marquee
rectangle around it.
Adding values
1. Select Tabulate, and then point to the value and click. Radios firea Circam
The new value is added in the next available column ; ?'g: ;'?3?.15 -
and row. Blank cells in the new column will be filled 3T 50T 0686 -
with a hyphen (-). 4 2.00 :12.5664 -
5 3.00 : 28.2743 -
2. Press TAB to record new values. 6| 0.50 ; 0.7854 3.14
7
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Sizing a table and deleting columns and rows
Sizing a table:

1. Click on the table. Point to the column divider and drag.

An edit window is displayed around the table. Bifin

Area
2. Point to any column divider in the first row. 1 0.53 126801
The cursor changes to the column width + cursor. New column width.

3. Drag the column to modify its width. fadinaiiven

0.63 : 1.2601
1.00 ;: 3.1416

M

Deleting a column:

1. Click in the first row of a column (the title column) to ~ Foint and click in the first row of a column.
select the column.

Radius Area Circum
The column is highlighted. 11 0,63 @ 1.2601 K
. 2| 1.00 31416 -
2. Press DELETE or select Clear in the Edit menu to delete TS0 068 =
the column. 4 2.00 i12.5664 -
3| 3.00 :28.2743 -
6| 0.50 0.7854 314
T

Deleting a row:

1. Click in a row of the first column (the sequentially Point and click in a row of the first column.
numbered column) to select the row.

The row is highlighted. 1 0635 12601
2. Press DELETE or select Clear in the Edit menu to delete 2100 3.1416
n U3 1,50 1 7.0686
the row. R 200 125664
5 3.00 i28.2743
6 0.50 | 0.7854
T
Copying permitted provided TI copyright notice is included Chapter 11: Using the Measure Toolbox 11-13

© 1997, 1999 Texas Instruments Incorporated



Chapter 12: Using the Display Toolbox

The Display toolbox contains the tools associated with display features in Cabri Geometry II. These
features allow you to annotate your constructions or animate objects.

The illustration below shows the location of the Display toolbox on the Cabri Geometry II toolbar,
along with its pull-down menu. Procedures for using Display tools, including examples, are
presented in this chapter in the order in which the tools appear on the pull-down menu.

Display toolbox

| O =z ] [2]E]

Label Al

Comments Ji
J_

Numerical Edit 2 . 1
Mark Angle .l'{i
Fix/Free E
Trace On/Off W

Animation |ig&~:

. L -
Multiple Animation ﬂ?é
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All Label

The Label tool attaches a label to a point, line, or circle. When you select an object with the Label
tool, an edit box appears in which you can enter the label text. The edit box contains pull-down
menus that allow you to specify the attributes of the text (Macintosh only).

You can also attach a label to a point immediately after it is created. This method limits text to five
characters, and you cannot edit when entering the text.

To set attribute defaults for font, size, and style of the text, use the Font, Size, and Style c*ommands
in the Options menu in the Macintosh version, or the Options/Preferences menu in the Windows
version.

Creating a label

1. Select Label from the Display toolbox. |_H IEEFEECIEEIaC ||

2. Click to select a point, line, or circle. Select a point, line, or circle.
An edit box appears.
This point
3. If the attributes are already as you desire, continue
to step 4. If not, select the font, size, style, and color A
of the text to be entered. Press and hold the mouse

button while pointing to the small icon boxes at the Enter a label.
top of the edit box.

The C, S, F, and color block M change the character
font, the character size, the font style, and the
character color.

4. Type the label text on the keyboard.

Modifying a label

Move a label by dragging it to a desired location using
the Pointer tool.

You can move the label within a fixed region from the
object it labels. The label maintains its relative position
to the object throughout any changes to the object.

Edit a label by selecting it with the Label tool. An edit
box appears for editing the text. You must shade the text
that you want to modify before making changes to its
font, size, style, or color. Shade the text by dragging the
I-beam cursor ( I') across it. Then select the appropriate
option.

Note: The DOS version lets you change the color of a
label by selecting the label, and then selecting a color
from the color palette, or by applying the Color tool.
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Comments

The Comments tool allows you to create an edit box to enter a text comment. Dragging a marquee
rectangle in the drawing window makes the edit box appear for you to enter your text . The edit
box contains pull-down menus that allow you to specify the attributes of your comment text. The
comment becomes a text object that you can move anywhere in the plane.

You can also add measurements and numerical values to comments. These values become a part
of the comment, yet maintain their numerical characteristics.

To set attribute defaults for font, size, and style of the text, use the Font, Size, and Style commands
in the Options menu in the Macintosh version, or the Options/Preferences menu in the Windows
version. You can also frame and/or fill comments with a color by using the Modify Appearance tool in
the Draw toolbox.

Creating a comment
1. Select Comments from the Display toolbox. |_|,] BRI [—-,|1:||

2. Drag a marquee rectangle to specify the location and Drag an appropriately sized box.
line length of the comment in the drawing.

An edit box appears when you release the mouse
button.

Enter a comment.

3. If the attributes are already as you desire, continue to
step 4. If not, select the font, size, style, and color of
the text that you want. Press and hold the mouse §The area of a circle is mr2.
button while pointing to the small icon boxes at the The area of circle ¢ =
top of the edit box.

The C, S, F, and color block M change the character font, Highlight and change the text style.
the character size, the font style, and the color of the
character.

n
ircle is mr2.
fle ¢ =

4. Type the text on the keyboard.

Text is confined within the box and automatically
wraps to the next line when near the boundary. Create
additional lines by pressing ENTER.

Extend
Owerbar

Superscript
Subscript

Orea Eoploration

The area of a circle is 7re
The area of circle ¢ =

Note: For Macintosh and DOS versions, to access some commonly used special characters, turn
on NUM LOCK on your keyboard. Then press the ALT key while entering the three-digit ASCII
number to insert the desired character.

224 o 228 > 232 (] 238 O 241 + 246 + 251 N
226 r 230 u 234 Q 239 n 242 > 247 = 252 3
227 b 231 Y 236 ) 240 = 243 < 248 ° 253 2
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Comments (Continued)

5. Point to a numerical value, and click to insert it at the
location of the I in the edit box.

Adding a comment to a numerical value
1. Select the Comments tool, then the numerical value.

2. Type the text. Press ENTER if you need additional
lines.

Text is confined within the box and does not wrap to
the next line. The comment is used as the column title
if this value is tabulated in the table.

Modifying a comment

Move a comment by dragging it anywhere in the plane
with the Pointer tool.

Edit a comment by selecting it with the Comments tool. An
edit box appears. You must shade text that you want to
modify before making changes to its font, size, style, or
color. Shade the text by dragging the I across it. Then
select the appropriate option.

Click directly on a numerical value within a comment to
change its characteristics. The options in the edit box
change to the options available in Numerical Edit . You can

then modify the numerical value. See “Numerical Edit" in this

chapter for specific details on editing a numerical value.

Resize the edit box by dragging its lower right-hand
corner.

Note: The Windows and DOS versions let you change the
color of a comment by selecting the comment, and then
selecting a color from the color palette, or by applying the
Color tool.

i

Orea Enploration

The area of a circle is e,
The area of circle ¢ = |

C

Include this number

Area: 3.14]6 cm?

Qrea Eoploration
The area of a circle is 7,
The area of circle ¢ = z.1416 em?

Edit this text

3.141d.cm?
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E Numerical Edit

The Numerical Edit tool creates an edit box for editing numerical values, including interactive
numbers or measurements. Interactive numbers can be modified interactively and used to define
rotations, dilations, or measurement transfer values. The edit box contains pull-down menus that

allow you to specify the attributes of the text.

Attribute defaults for font, size, and style of the text can be set using the Font, Size, and Style

commands in the Options menu (Macintosh only).

Creating and editing numerical values
1. Select Numerical Edit from the Display toolbox.

2. Click to place an edit box anywhere in the drawing
for creating an interactive number.

3. If the attributes are already as you desire, continue
to step 4. If not, select the font, size, style, and color
of the text that you want. Press and hold the mouse
button while pointing to the small icon boxes at the
top of the edit box.

The C, S, F, and color block m change the character
font, the character size, the font style, and the
character color.

4. Type a numerical value.

5. Press and hold the mouse button while pointing to
the U (Macintosh) in the edit box or press CTRL+U
(Windows and DOS) to assign units to the
interactive number.

Note: The Windows and DOS versions let you
change the color of a numerical value by selecting it,
and then selecting a color from the color palette, or
by applying the Color tool.

EREEEFPECEEIEE]

Click to place the edit box.

Enter a numerical value.

Add appropriate units.

a5

Without unit

Hillirneter

Centimeter

Meter

Eilarmeter

Square MMillimeter

Square Centimeter

Square Meter

Square Kilometer

Radian |

Degres
Grad k
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Numerical Edit (Continued)

Modifying a numerical value

Move the numerical value by dragging it anywhere in the
plane with the Pointer tool.

You can modify numerical values interactively when the
edit box is active. Using the arrow keys, place the I to the
right of the digit you want to change. Use the up-arrow key
to increase the digit by 1. Use the down- arrow key to
decrease the digit by 1.

You can change these values automatically with
animation. Using the Animation tool, select the number as
you would select any object. The digit increases or
decreases relative to the cursor position and to the
direction indicated by the Animation tool.

You can change the units of a numerical value or its
displayed precision. Using the Numerical Edit tool, select the
numerical value. Select the U (Macintosh) in the edit box
or press CTRL+U (Windows and DOS), and assign a unit to
any number or change to the desired units.

Cabri Geometry II performs unit conversions based on the
number's current unit assignment. Press the + key to
increase the precision displayed by 1 digit. Press the — key
to decrease the precision displayed by 1 digit.

Change the character attributes of a numerical value by
selecting it using the Numerical Edit tool. An edit box
appears for editing the number. You must shade the text
that you want to modify before making changes to its font,
size, style, or color. Shade the text by dragging the I across
it. Then select the appropriate option from the icons in the
edit box.

12-6

Chapter 12: Using the Display Toolbox

Copying permitted provided TI copyright notice is included
© 1997, 1999 Texas Instruments Incorporated



Mark Angle

The Mark Angle tool labels an angle specified by three points with an angle mark.

Creating a marked angle

1. Select Mark Angle from the Display toolbox. |_|.,j -l M = [—|1:||

2. Specify the angle by selecting three points. The second Select three points.
point must be the vertex.

Note: To measure an angle, just select the marked
angle with the Angle tool in the Measure toolbox.

Drag the mark through the vertex to
measure the reflex angle.

Modifying an angle mark

Using the Pointer tool, modify an angle mark by dragging it
through the vertex to measure the opposite angle. The
angle mark changes to L] when the angle is 90 degrees.

Using the Modify Appearance tool in the Draw toolbox, change
the number of angle marks displayed by selecting the
desired angle mark attribute, and then the angle mark.

Example

Mark two angles:

120,000 180,000
120000 ° &0.000 %

120.000 * 0,000 ©
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Fix/Free

The Fix/Free tool fixes the location of a free point or vice versa. Fixed points cannot be moved or
deleted.

Fixing or freeing points

1. Select Fix/Free from the Display toolbox. NREEEFEEEIEENEO)
All fixed points are displayed with a thumb tack next
to them.

2. Select any free point to fix its location or any fixed Select any point to fix its position.
point to free the location constraint. This point

The Fix/Free tool works as a toggle function on a
point. To free all fixed points simultaneously, click in
free space while pressing SHIFT.
Select any fixed point to free it.

This point
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« | Trace On/Off

The Trace On/Off tool traces the path of an object as it is translated. You may trace objects manually
by dragging the object or automatically by using the Animation tool. Multiple objects can be selected
for tracing.

To clear trace results, select Refresh Drawing in the Edit menu.

Tracing an object
1. Select Trace On/Off from the Display toolbox. | o At Mo 4 5 ﬂl

2. Select the object to trace. Select any object.

.=---This circle
Selected objects are displayed in marquee outline. h

3. Disable the trace on an object by selecting the object
displayed in marquee outline.

. Move the object to show the trace.
The Trace On/Off tool works as a toggle function on an v

object. To disable a trace on all objects
simultaneously, click in free space while pressing
SHIFT.

Modifying a trace

Use the Pointer tools (see Pointer toolbox) to modify the
construction. As you move the object, its outline is
displayed.
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@ Animation

The Animation tool automatically moves an independent object along a specified path. Direction and
speed are determined by the animation “spring.” You can increase or decrease the animation speed
by pressing + or — respectively, while the animation is active.

Objects defined by Trace are displayed at a specific interval relative to the length of the path. If the
tabulation table is selected prior to the animation, animation automatically enters tabulation data
into the table at a predetermined interval. (See “Tabulate " in the chapter “Using the Measure
Toolbox.”)

Animating an object
1. Select Animation from the Display toolbox. | IR EEEEEIREET 1”

2. Place the cursor on any object, and drag the Drag the animation spring.
animation spring in the opposite direction to the
intended animation.

The farther away the spring is pulled, the faster the
object is animated. The animation begins when the
mouse button is released and the spring collapses.

If the Pointer tool is visible in the toolbar and the
object does not lie on a defined path, the animated
direction is 180 degrees from the spring. Otherwise,
the object is animated along its defined path. Release the mouse button to begin.

If the Rotate, Dilate, or Rotate and Dilate tool is visible in ,@l
the Pointer toolbox and the object can be transformed, i
the animation will be relative to the visible Pointer
tool. For example, if the Rotate tool is visible, the
object is rotated automatically.

3. Stop the animation by clicking anywhere on the
drawing,.
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#*%| Multiple Animation

The Multiple Animation  tool automatically moves multiple objects along specified paths. Direction
and speed are determined by the objects’ individual animation “spring.” You can increase or
decrease the speed of the total animation by pressing + or —, respectively, during the animation.

Objects defined by Trace are displayed at a specific interval relative to the length of the path. If the
tabulation table is selected prior to the multiple animation, multiple animation automatically
enters tabulation data into the table at a predetermined interval.(See “Tabulate ” in the chapter
“Using the Measure Toolbox.”)

Using Multiple Animation

1. Select Multiple Animation from the Display toolbox. |_H IR l"—|i||

Drag the animation spring.

2. Place the cursor on any object, and drag an
animation spring in the opposite direction to the

intended animation. Select as many objects as
desired for the animation. Redefine any animation
spring by selecting the object again.

The farther away the spring is pulled, the faster the Press ENTER fo begin.
object is animated. The animation spring remains in
place after the mouse button is released.

If the object does not lie on a defined path, the
animated direction is 180 degrees from the spring.
Otherwise, the object is animated relative to its
defined path. Multiple Animation does not work with

other Pointer tools as does Animation . Note: The point on the circle was

selected to trace.
3. Press ENTER to begin the animation.

4. Stop the animation by clicking anywhere on the
drawing.
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Chapter 13: Using the Draw Toolbox

The Draw toolbox contains the tools associated with drawing features in Cabri Geometry II. These
features allow you to change the appearance of objects or display the coordinate system.

The illustration below shows the location of the Draw toolbox on the Cabri Geometry II toolbar,
along with its pull-down menu. Procedures for using Draw tools, including examples, are presented
in this chapter in the order in which the tools appear on the pull-down menu.

Draw toolbox

| D x| e Al

Hide/Show

=
Color Vi
&
=

Fill

Thick

Dotted

. A
Modify Appearance O
[
Show/Hide Axes #
-

New Axes

Define Grid __'}'_H

B
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Hide/Show

The Hide/Show tool hides from view all selected objects and their accompanying labels and
measurements. It also shows selected hidden objects. Hiding objects does not alter any of their

attributes or geometric roles in a construction.

Hiding and showing objects

1. Select Hide/Show from the Draw toolbox.

2. Select the object you want to hide.

Note: Hidden objects are shown in dotted outline
when the Hide/Show tool is active; otherwise, they are
invisible.

Pressing the OPTION key (Macintosh) or the CTRL key

(DOS) filters the cursor messages for all hidden
objects, allowing easier access to visible objects.

3. Select a hidden object to make it visible again.

Pressing SHIFT and clicking in free space makes all
hidden objects visible.

Pressing OPTION+SHIFT (Macintosh) or CTRL+SHIFT
(DOS) filters the cursor messages for all visible
objects, allowing easier access to hidden objects.

DEEEEECEER 3

Click to hide visible objects.

: Thisline :

__________ R L

Selected objects are hidden.

Click to display hidden objects.

ircle

13-2

Chapter 13: Using the Draw Toolbox

Copying permitted provided TI copyright notice is included
© 1997, 1999 Texas Instruments Incorporated



Eﬂ(mm

The Color tool changes the color of any object to one of 15 colors in the color palette. (This tool
does not display on black and white systems.

Changing the color of an object

1. Select Color from the Draw toolbox.

[ -

A Moix] = AL

2. Select one of the colors in the color palette. Select a color from the palette.

e
|| |
|| | |
o | (]

The selected color appears outlined in the palette.

Select any object to change its color to the color you

selected. Select object to change its color.
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&1 Fil

The Fill tool fills an object such as a triangle, polygon, circle, or label with a color (or pattern for
black and white systems) that you choose from 15 selections available in the color palette.

Filling an object with color

1. Select Fill from the Draw toolbox.

DEEEFECEEED
2. Select one of the colors (patterns appear on black and Select a fill color from the palette.
white systems ) in the color palette. O————
| ] | |
| | | | |
o o
3. Select an object. Select object to fill with color.

Modifying a filled object

Select an object a second time with the same color to

change the color to transparent white (the original fill
color).

Select an object a second time while pressing the OPTION
key (Macintosh) or the ALT key (Windows, DOS) to change
the color to opaque white.

Example
Construct a star polygon Fill the star polygon
with the Regular Polygon  tool. with color.
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Thick

The Thick tool changes the outline thickness of an object.

Changing outline thickness
1. Select Thick from the Draw toolbox. |_H IR i'E

2. Select the thickness for the outline. Select the thickness attributes.

(——r7r—x
24

3. Select the object to be outlined. Select an object.
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:I Dotted

The Dotted tool changes the outline pattern of an object.

Changing outline pattern
1. Select Dotted from the Draw toolbox. MEEEFErEEE N

2. Select the pattern for the outline. Select the outline attribule.

3. Select the object to be outlined. Select an object.

by 1

1
1
n 1
I
I

I
I
1 1
1
1
1
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Modify Appearance

The Modify Appearance tool changes the appearance of a point, the tick marks of an angle or a
segment, the type of coordinate system, or the style of a comment.

Modifying appearances

1. Select Modify Appearance from the Draw toolbox.

2. Select the appropriate option: Select attributes to modify.

(e———7—r

» Points: small, medium, large, circular, or cross. D_'ID LI lI iI

» Angle marks: one, two, or three tick marks. ':' él Q
O

» Segments: zero, one, two, or three tick marks. il ﬂ il

» Coordinate system: Cartesian or polar coordinates. = ol
O

Polar coordinates can be represented in degrees, !I@!l

gradlents’ or radians. Select corresponding objects.

» Comments: transparent without border, opaque

without border, transparent with border, or opaque

with border. '
3. Select the object you want to appear with the selected
attribute.

Example

1. Select the polar coordinate attribute.

yann

=+

3. Coordinate system changes to polar.

2. Select the xy-coordinate system.

¥

These axes *
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“ | Show/Hide Axes

The Show/Hide Axes tool displays the default axes. This command toggles between Show Axes and
Hide Axes . If the axes are visible, the Hide Axes tool appears in the toolbox; if not, the Show Axes tool
appears.

Equations and coordinates adhere to the specified coordinate system. Measurements of length,
area, slope, and angle are given relative to their physical measure. The default coordinate system is
defined in one centimeter increments, which corresponds to the physical measure you see. The
coordinate system may be either Cartesian or polar. You can change the system by using the Modify
Appearance tool, setting the defaults in the Options menu, or selecting the axes and pressing TAB.

Specifying axes
1. Select Show/Hide Axes from the Draw toolbox. |_H FEEFEFEREE l'F-:l
2. Coordinate system translation: Axes are displayed when you choose this tool.

¥
Drag the origin to translate the axes to a new

location.
3. Axes rotation:

Rotate both axes simultaneously by grabbing the )
x-axis beyond the first scale mark and dragging x
in a circular manner.

Rotate the y-axis separately by grabbing the
y-axis beyond the first scale mark and dragging in
a circular manner.

Note: Pressing the SHIFT key while dragging

rotates the axes in 15-degree increments. Drag the first scale mark

to change the scale.

4. Changing scale: y

Change the scale of both axes simultaneously by
dragging the first scale mark on the x-axis to the
desired location. The small number next to the
first scale mark indicates the value of each
division. x

Change the scale of the y-axis separately by
dragging the first scale mark on the y-axis to the
desired location.

Note: Pressing the shift key while dragging Drag x- or y-axis to rotate
returns the scale to the 1-centimeter increment the coordinate system.

default scale. y
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Eg New Axes

The New Axes tool creates a new x-y axis defined by three points. The first point defines the origin,
the second point defines the location of the x-axis, and the third point defines the location of the
y-axis. If the axes are defined using existing points, the points determine the scale of the axes.
Otherwise, the scale is defined in one-centimeter increments.

You can define multiple coordinate systems. Equations and coordinates and grids must be
specified relative to a specific coordinate system if multiple coordinate systems are defined.

After defining a new coordinate system, you can manipulate it in the same manner as the default
coordinate system documented in the previous tool, Show/Hide Axes .

Creating axes

1. Select New Axes from the Draw toolbox. |_H IEEFEREEE :_'|

2. Designate a point for the origin. Click to place the origin point.

3. Click to specify the location of the x-axis.

4. Click to specify the location of the y-axis.

Click to place the x-axis.

—_— 1

e

Click to place the y-axis.
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.

Define Grid

The Define Grid tool displays the grid of a defined coordinate system.

Defining and deleting a grid
1. Select Define Grid from the Draw toolbox. |_H IR 4||'_:|
2. Select the coordinate system to display the grid. Click to select the coordinate system.
¥
3. Delete the grid by selecting one of the grid points and These axes

pressing DELETE.

13-10 Chapter 13: Using the Draw Toolbox Copying permitted provided TI copyright notice is included
© 1997, 1999 Texas Instruments Incorporated



Index

A

adjusting your system configuration, 1-4
ambiguities, handling, 1-12

Angle tool, 11-5

animating an object, 12-10

Animation tool, 12-10

Arc tool, 6-3

Area tool, 11-3

arrow pointer, 1-10

attribute icons, description, 1-7
Automatic button, using to configure memory, 1-4
automatic data collection, 11-11

C

Calculate tool, 11-7
calculating measurements, 11-7 through 11-10
changing
appearance of objects, 1-19
color of an object, 13-3
column width, 11-13
constructed lines, 5-3
direction and slope of a constructed ray, 5-5
language, 2-10
memory allocation, 1-4
outline patterns, 13-6
outline thickness, 13-5
system configuration, 1-4
Check Property toolbox, 10-1
checking
angles, 11-5
areas, 11-3
collinearity, 10-2
equation or coordinates, 11-6
equidistant property, 10-5
membership, 10-6
parallelism, 10-3
perpendicularity, 10-4
slopes, 11-4
Circle tool, 6-2
Clear command, 2-5
close box, description, 1-7
Close command, 2-2
closing the active drawing window, 2-2
closing the program, 2-4
Collinear tool, 10-2
Color tool, 13-3
column width pointer, 1-10
Comments tool, 12-3
Compass tool, 7-8
configuring
memory setting, 1-5
number of objects, 1-6
number of screen colors, 1-5
toolbar tools, 2-9
Conic tool, 6-4

constraining the slope of a line, 5-2
Construct toolbox, 7-1
constructing objects, 1-10
construction pencil pointer, 1-10
Copy command, 2-5
creating
angle bisectors, 7-6
arcs, 6-3
axes, 13-9
calculations, 11-10
circles, 6-2
comments, 12-3
compass circles, 7-8
conics, 6-4
intersection points, 4-4
inverse points, 8-7
labels, 12-2
lines, 5-2
loci, 7-11
macros, rules for, 9-2
marked angles, 12-7
measurement transfers, 7-9
midpoints, 7-4
numerical values, 12-5
parallel lines, 7-3
perpendicular bisectors, 7-5
perpendicular lines, 7-2
points, 4-2
points on an object, 4-3
polygons, 5-8
rays, 5-5
reflections, 8-2
regular polygons, 5-9
segments, 5-4
symmetrical images, 8-3
triangles, 5-7
vector sum, 7-7
vectors, 5-6
creating and selecting points, basics, 1-10
cross hair pointer, 1-10
crossed lines pointer, 1-10
Curves toolbox, 6-1
Cut command, 2-5

D

Defaults command, 2-7
Define Grid tool, 13-10
Define Macro tool, 9-5
defining a grid, 13-10
deleting objects, 1-17

determining dependent and independent objects, 1-12

Dilate tool, 3-4
dilating
an object, 8-6
objects, 3-4, 3-5
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Dilation tool, 8-6 G
Display toolbox, 12-1
Distance & Length tool, 11-2 grasping hand pointer, 1-10

Dotted tool, 13-6

dragging hand pointer, 1-10

dragging objects, 1-13 H
(I?r aw tooll?ozi(, 13'} 6 Help menu, 2-12
rawing window, 1- Hide/Show tool, 13-2
hiding and showing objects, 13-2
E
Edit menu, 2-5, 2-6 /
editing

I-beam pointer, 1-10
comments, 12-4 L. .

labels 12 2’ Initial Object tool, 9-3
abels,| 12 initial point of a line, 5-2

numerlcal Valugs, 12:5 installing the software, 1-2
Equation & Coordinates tool, 11-6 Intersection Point(s) tool, 44

Equidistant tool, 10-5 Inverse tool, 8-7

examples
arcs, creating, 6-3
basic points, 1-13 L
comments, 1-21
conics, creating, 6-4 Label tool, 12-2
dependent objects, 1-14 labeling objects, 1-19, 12-2
independent objects, 1-14 language, changing, 2-10
labeling, 1-19 Line tool, 5-2
lines, creating, 5-3 Lines toolbox, 5-1
locus, creating a, 7-11 Locus tool, 7-11
marked angles, creating, 12-7 low memory message, 1-4

measurement transfers, creating, 7-9

modifying appearances, 13-7
parallel lines, creating, 7-3 M
perpendicular bisectors, 1-11
perpendicular lines, creating, 7-2
rotating and dilating, 3-5
segments, creating, 5-4
selecting multiple objects, 3-2
expanding or contracting an object. See dilating an

Macro toolbox, 9-1

magnifying glass pointer, 1-10
Mark Angle tool, 12-7

Measure toolbox, 11-1
Measurement Transfer tool, 7-9
measuring objects, 11-2

object Member tool, 10-6
memory, available for application, 1-4
E Menu bar, description, 1-6
menus, options, 1-8
File menu, 2-2, 2-3, 2-4 Midpoint tool, 7-4
Fill tool, 13-4 Modify Appearance tool, 13-7
filling an object with color, 13-4 modifying
Final Object tool, 9-4 a point on an object, 4-3
Fix/Free tool, 12-8 angle bisectors, 7-6
fixing or freeing points, 12-8 appearances, 13-9
Font command, 2-11 arcs, 6-3
freehand rotation of an object, 3-5 circles, 6-2
function buttons, calculate window,|11-8 comments, 12-4
functions and syntax, calculate window, 11-9 compass circles, 7-8
conics, 6-4
dilations, 8-6
equation or coordinates, 11-6
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modifying (continued)
inverse points, 8-7
labels, 12-2
lines, 5-2
loci, 7-12
marked angles, 12-7
modifying (cont.)
measurement transfers, 7-10
midpoints, 7-4
numerical values, 12-6
parallel lines, 7-3
perpendicular bisectors,|7-5
perpendicular lines, 7-2
points, 4-2
rays, 5-5
reflections, 8-2
regular polygons, 5-10
rotations, 8-5
segments, 5-4
symmetrical images, 8-3
traces, 12-9
translations, 8-4
triangles, 5-7
vector sum, 7-7
vectors, 5-6
moving measurements
area, 11-3
of an object, 11-2
of angles, 11-5
slope, 114
moving objects, 3-2
Multiple Animation tool, 12-11

P

Page Setup command, 2-3, 2-4
paint brush pointer, 1-10

paint bucket pointer, 1-10
paper size and orientation, 2-3, 2-4
Parallel Line tool, 7-3

Parallel tool, 10-3

Paste command, |2-5
Perpendicular Bisector tool, 7-5
Perpendicular Line tool, 7-2
Perpendicular tool, 10-4

Point on Object tool, 4-3

Point tool, 4-2

Pointer tool, 3-2

Pointer toolbox, 3-1

pointers, display types, 1-10
pointing hand pointer, 1-10
Points toolbox, 4-1

Polygon tool, 5-8

Preferences command, 2-7
Print command, 2-4

Printer Setup command, 2-4
printing a construction file, 1-22, 2-4
printing options, 2-4

printing to scale, 2-3, 2-4

Q

Quit command, 2-4

N

network operation, 1-3
New Axes tool, 13-9
New command, 2-2

O

On-line help window, how to open, 1-9
Open command, 2-2

open hand pointer, 1-10

opening a new drawing window, 2-2
opening an existing construction file, 2-2
optimal configuration settings, 1-4
optimizing your system configuration, 1-4
Options menu, 2-7 through 2-10

R

Ray tool, 5-5

Redefine Object tool,|7-14

Redefine Point tool, 7-13

redefining an object, 7-14

redefining a point, 7-13

Redo command, 1-17, 2-5

Reflection tool, 8-2

Regular Polygon tool, 5-9

removing selected objects, 2-5

Replay Construction command, 2-6
replaying each step of a construction, 2-6
returning to a recently saved version, 2-3
Revert command, 2-3

Rotate and Dilate tool, 3-5

Rotate tool, 3-3

rotating an object, 3-3, 8-5

rotating an object automatically, 3-3
Rotation tool, 8-5
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S

Save and Save As command, 2-2
saving a construction file, 1-22, 2-2
scroll bars, description, 1-7
scrolling the drawing window, 1-22
Segment tool, 5-4
Select All command, 2-6
selecting

all objects, 2-5

default colors and attribute settings, 2-7

objects, 3-2

preferences, 2-7
selection hand pointer, 1-10
selection pencil pointer, 1-10
selection pointer, description,|1-7
setting preferences, 2-7
Show Drawing command, 2-3
Show/Hide Attributes command, 2-7
Show/Hide Axes tool, 13-8
size box, description, 1-7
Size command, 2-11
Slope tool, 11-4
specifying

axes, 13-8

final objects, 9-4

initial objects, 9-3

macros, 9-6
starting the program, 1-3
status, checking, 1-5
storing a macro in memory, 9-2, 9-5
Style command, 2-11, 2-12
Symmetry tool, 8-3
system requirements, 1-2

toolboxes

Check Property, 10-1
Construct, 7-1

Curves, 6-1
Display, 12-1
Draw, 13-1
Lines, 5-1
Macro, 9-1

Measure, 11-1

Pointer, 3-1
Points, 4-1

Transform,|8-1
Trace On/Off tool, 12-9
tracing an object, 12-9
Transform toolbox, 8-1

translating
lines, 5-2
objects, 8-4
rays, 5-5

segments, 5-4

vectors, constructed, 5-6
Translation tool, 8-4
Triangle tool, 5-7

U

Undo command, 1-17, 2-5
using the software on a network, 1-3

T

table dimensions, using Tabulate, 11-11
Tabulate tool
adding values, 11-12
description, 11-11
sizing and deleting columns, 11-13
using tabulate, 11-12
Thick tool, 13-5
Tool Configuration command, 2-9
Toolbar, description, 1-7

%4

Vector Sum tool, 7-7

Vector tool, 5-6
viewing

font sizes, 2-11
installed fonts, 2-11
text styles, 2-11
viewing an entire region, 2-3
viewing available system memory, 1-4

V4

zoom box, description, 1-7

Index-4

Copying permitted provided TI copyright notice is included

© 1997, 1999 Texas Instruments Incorporated



	Front Matter
	Important
	Permission to Print
	TI Product and Services Information
	About Cabri Geometry II
	About the Developers
	Cabri Geometry II Features

	Table of Contents
	About this Guidebook
	Structure
	Definitions

	Chapter 1: Learning the Basics
	First Steps
	Checking system requirements
	Installing Cabri Geometry II
	Installing Cabri Geometry II on a network
	Starting Cabri Geometry II
	Optimizing your Macintosh system configuration
	Changing your Macintosh system configuration using Cabri II
	The Cabri Geometry II window
	Elements of the Cabri Geometry II window
	About menus and toolboxes
	Accessing on-line help

	Constructing Objects
	Pointers that guide you
	Creating and selecting point's
	Handling ambiguities
	Determining dependent and independent objects
	Dragging
	Using the Undo/Redo command
	Deleting objects
	Changing the Appearance of Objects
	Labeling objects
	Scrolling the drawing window
	Saving and printing


	Chapter 2: Using the Menus
	File Menu
	New
	Open...
	Close
	Save
	Save as...
	Revert...
	Show Drawing...
	Show Page...
	Page Setup...
	Print...
	Printer Setup...
	Print...
	Quit

	Edit Menu
	Undo/Redo
	Cut/Copy/Paste
	Clear
	Select all
	Replay Construction
	Refresh Drawing

	Options Menu
	Hide/Show Attributes
	Defaults...
	Preferences...
	Tool Configuration...
	Languages
	Font
	Size
	Style

	Help Menu
	Help
	About (Cabri II)


	Chapter 3: Using the Pointer Toolbox
	Pointer
	Selecting or moving objects

	Rotate
	Rotating objects

	Dilate
	Dilating objects

	Rotate and Dilate
	Using Rotate and Dilate


	Chapter 4: Using the Points Toolbox
	Point
	Creating a point
	Modifying a point
	Point on Object
	Creating a point on an object
	Modifying a point on an object

	Intersection Point(s)
	Creating an intersection point
	Modifying an intersection point


	Chapter 5: Using the Lines Toolbox
	Line
	Creating a line
	Modifying a line
	Creating a segment
	Modifying a segment

	Ray
	Creating a ray
	Modifying a ray

	Vector
	Creating a vector
	Modifying a vector

	Triangle
	Creating a triangle
	Modifying a triangle

	Polygon
	Creating a polygon
	Modifying a polygon

	Regular Polygon
	Creating a regular polygon
	Modifying a regular polygon


	Chapter 6: Using the Curves Toolbox
	Circle
	Creating a circle
	Modifying a circle

	Arc
	Creating an arc
	Modifying an arc

	Conic
	Creating a conic
	Modifying a conic


	Chapter 7: Using the Construct Toolbox
	Perpendicular Line
	Creating a perpendicular line
	Modifying a perpendicular line

	Parallel Line
	Creating a parallel line
	Modifying a parallel line

	Midpoint
	Creating a midpoint
	Modifying a midpoint

	Perpendicular Bisector
	Creating a perpendicular bisector
	Modifying a perpendicular bisector

	Angle Bisector
	Creating an angle bisector
	Modifying an angle bisector

	Vector Sum
	Creating a vector sum
	Modifying a vector sum

	Compass
	Creating a circle using Compass
	Modifying a circle created using Compass

	Measurement Transfer
	Creating a measurement transfer
	Modifying a measurement transfer

	Locus
	Creating a locus
	Modifying a locus

	Redefine Point
	Redefining a point
	Redefine Object
	Redefining an object


	Chapter 8: Using the Transform Toolbox
	Reflection
	Creating a reflection
	Modifying a reflection

	Symmetry
	Creating a symmetrical image
	Modifying a symmetrical image

	Translation
	Translating an object
	Modifying a translation

	Rotation
	Rotating an object
	Modifying a rotation

	Dilation
	Dilating an object
	Modifying a dilation

	Inverse
	Creating an inverse point
	Modifying an inverse point


	Chapter 9: Using the Macro Toolbox
	How to create a macro
	Rules for creating macros

	Initial Object
	Specifying initial object(s)

	Final Object
	Specifying final object(s)

	Define Macro
	The Define Macro dialog box
	Specifying a macro


	Chapter 10: Using the Check Property Toolbox
	Collinear
	Checking collinearity

	Parallel
	Check parallelism

	Perpendicular
	Checking perpendicularity

	Equidistant
	Checking equidistant property

	Member
	Checking membership


	Chapter 11: Using the Measure Toolbox
	Distance & Length
	Measuring objects
	Moving measurements

	Area
	Checking area
	Moving measurements

	Slope
	Checking slope
	Moving measurements

	Angle
	Checking angles
	Moving measurements

	Equation & Coordinates
	Checking equation or coordinates
	Modifying the equation or coordinates

	Calculate
	Entering a calculation
	Editing a calculation

	Tabulate
	Using Tabulate
	Adding values
	Sizing a table and deleting columns and rows


	Chapter 12: Using the Display Toolbox
	Label
	Creating a label
	Modifying a label

	Comments
	Creating a comment

	Numerical Edit
	Creating and editing numerical values
	Modifying a numerical value

	Mark Angle
	Creating a marked angle
	Modifying an angle mark mark

	Fix/Free
	Fixing or freeing points

	Trace On/Off
	Tracing an object
	Modifying a trace

	Animation
	Animating an object

	Multiple Animation
	Using Multiple Animation


	Chapter 13: Using the Draw Toolbox
	Hide/Show
	Hiding and showing objects

	Color
	Changing the color of an object

	Fill
	Filling an object with color
	Modifying a filled object

	Thick
	Changing outline thickness

	Dotted
	Changing outline pattern

	Modify Appearance
	Modifying appearances

	Show/Hide Axes
	Specifying axes

	New Axes
	Creating axes

	Define Grid
	Defining and deleting a grid


	Index

